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Introduction

The Geomar TrackMaker601 Data Logging System consists of a data logging program Nav601
and associated PC computer program TrackMaker601. TrackMaker601 is used to process data
files recorded under the control of program NAV601.

The program supports current Windows 10 based data acquisition program Nav601 for tablets
and field laptop computers, as well as versions Nav601wm and Nav601wg for Windows Mo-

bile based devices. The TrackMaker601 program is backward compatible, it can process and
recognizes data file formats created with various versions of NAV601 automatically. However,
TrackMaker601 V2.00 or later must be used to process data files collected with Nav601 for Win-
dows 10 based devices.

1.1 About the TrackMaker601

The program TrackMaker601 is a Windows based program for IBM PC compatible com-
puters operating under Windows 10/7/XP/2000 or later. The program TrackMaker601

is designed to process data collected by a field computer under the control of programs
NAV601. The program can be used to position Grad601 sensor based on real time GPS
data and with grid based data (surveys positioned without GPS receiver). The program
allows you also to convert to ASCII text file format, to position field comments, generate
position file for stand-alone GPS positions (GXY), and to correct created XYZ files for
a delay (latency) caused by the system time constant.

Main function of this program is to position Bartington Grad601 records based on the
recorded GPS position, the instant heading of the system, the configuration of the sys-
tem, and several user specified filters. Configuration of the system is described by num-
ber of sensors and separation between them (two sensors only) and by offsets of the GPS
antenna from the center of the Grad601 system. The program calculates real position of
the instrument based on specified GPS antenna offset and direction of the movement.
However, it is highly recommended that GPS antenna is placed as close as possible to
the center of the Grad601 system as this configuration provides the best accuracy. Op-
tionally elevation data can be written to the output file. The program corrects elevation
data for the GPS antenna height. The program can process seven different NMEA GPS
messages recorded by data acquisition software NAV601: a pair GGA/GSA, GGA, POS,
LLK, LLQ, GLL, and GGK (Trimble and Leica versions). In addition program handles
interface of pseudo-GGA (Robotics Total Station manufactured by Leica, Trimble, and
several other brands) and psudo-GLL available in some marine positioning systems.
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The TrackMaker601 uses data files in NAV601 format which have extension name 601.
These are binary files with a record length of 27 bytes terminated by Line Feed charac-
ter. These files can be viewed in standard text editor however care should be taken to
avoid accidental Save or Save As that can corrupt binary files. The program can also pro-
cess files with extension GXY. The GXY file contains stand-alone GPS positions if the
NAV601 program was used to collect GPS data only. These files are also binary (records
are 27 bytes for Windows CE based program and terminated by Line Feed character)
and care should be taken if they are viewed with text editors. Files GXY generated by
any other Geomar data acquisition program i.e. ML61, NAV61, NAV31, etc. are fully
compatible and they can be processed by TrackMaker601.

One sample NAV601 data file, 052012A.601 is included on the program disk. It allows
the user to become familiar with running the TrackMaker601 program.

1.2 Contents of TrackMaker601 Distribution Disk

The TrackMaker601 software is supplied on one CD disk. Disk contains following files
and directories:

SetupT60l.exe -  setup program for TrackMaker601

SetupNav601 - installation for Windows 10 based data acquisition pro-
gram Nav601 (alternatively it is replaced by Nav601 or
Nav601wg programs for Windows Mobile)

Documentation -  directory containing all NAV601 and TrackMaker601, and
other available Geomar manuals in PDF format.

DemoPrograms -  available demo versions for other Geomar programs.

The Software can be supplied on a CD disk or USB memory stick, or by download
from provided link to Geomar server. When electronic download is used files are often
named showing their version number, for example SetupT601.exe can be posted as
SetupT61MK2_ V201.exe to indicate that the setup program contains program Track-
Maker61MK?2 version 2.01.

% TrackMaker601 User's Manual



1.3 TrackMaker601 Software Installation

TrackMaker601 software uses a setup program to load files necessary for data process-
ing onto your computer. The following section describes the installation process. To
install TrackMaker601: Insert the TrackMaker601 CD disk or USB drive into CD drive
or to USB slot. Alternatively use the SetupT601 file in Windows Explorer if the software
was downloaded. Exit all Windows applications before installing the program. From the
Windows File Manager, select Run from the Windows System menu (or simply press key
Windows + R). The Run dialog box opens (Figure 1.1).

== Typethe name of a program, folder, document, or Internet

=

resource, and Windows will open it for you.

Open: | Ch\Downloads\SetupT601.exe w

Cancel Browse...

Figure 1.1:  Run Dialog window

Browse for the file SetupT601.exe in the CD or USB diskdirectory of the diskette. Click
OK to launch the Setup program. Once the Setup determines your computer configura-
tion the Welcome window opens (Figure 1.2).

I;',' TrackMakerf01 Setup

Geomar Software Inc.
Welcome to the installer for Track Makers01 V2.00.

It is strangly recommended that you exit all Windows programs
befare continuing with this installation.

If you have any other programs running, please click Cancel,
close the programs, and run this setup again.

Otherwise, click Next to continue.

Cancel

Figure 1.2:  Welcome window

Read the text and click on the Next button. The License Agreement window will be
displayed (Figure 1.3).
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B8 TrackMakerf01 Setup

Tems And Conditions ~
This program is provided "AS 15", Geomar Software Inc. is NOT responsible for any damage

{or damages) attributed to TrackMaker&01 or its field component Nav&01 (or equivalent
MNavE01wm and MNav&01wa). You are wamed that you use the program at your own risk. No
warranties are implied or given by Geomar Software or any representative.

This license cannot be sold, loaned, or donated to a third person or company.

Usage
This package is a single user license only. The software can be installed on muttiple
computers. While the associated data acquisition program Nav601 for equivalent NavE01wm
or NavB01wg) can be used on one field computer only at any time the data processing
program TrackMaker601 can be used on three computers simuttaneously within the

i btk

nnnnnn T R

(@ i agree to the terms of this license agreement;

(O) 1do not agree to the tems of this license agreement

- RN -

Figure 1.3: License Agreement window

Read the text and click the Next button. The Serial Number window will be displayed
(Figure 1.4).

B8 TrackMakerf01 Setup

er your serial number and click Next to continue.

Serial number is case sensitive, please use UPPER CASEfor non numeric characters.
Serial Number:

s

| Bk | [ wew> || cancal

Figure 1.4: Installation Directory window

Type the Serial Number (it is provided on the CD disk or USB drive, in case of download
it will be provided) into the provided box and press the Next button. (If you do not know
the Serial Number, you will not be able to continue.) This entry is case sensitive, please
use Upper Case for characters. The Installation Directory window opens (Figure 1.5).
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B8 TrackMakerf01 Setup

ere would you like Track Maker01 to be installed 7

The software will be installed in the folder listed below. To select a different location, either type in a
new path, or click Change to browse for an existing folder.

Install Track Makert01 to:
C:\Program Files (x36)\TrackMaker601 || T |

Space required: 8.08 MB
Space available on selected drive: 22554 GB

| cBak | [ WNewz N | Canesl |

Figure 1.5:  Select Installation Directory window

A default directory is C:\Program Files\TrackMaker601. Click the Next button to install
the program to this directory. If you wish to install the program to another directory,
click the Change button and the Select Installation Directory window will open. Click
the Next button. The Select Short cut Folder window opens (Figure 1.6).

%8 TrackMaker601 Setup

ere would you like the shotcuts to be installed?

The shortcut icons wil be created in the folder indicated below. f you don't want to use the default
folder, you can either type a new name, or select an existing folder from the list.

Shorteut Folder:
[TrackMaker501 -

(O Install shortcuts for cument user only
(@ Make shortcuts avaiable to all users

| <Back | | Rexs[s | | Caneel |

Figure 1.6:  Select Shortcut Folder window

The setup program will create a TrackMaker601 menu item in the Program menu ac-
cessible by clicking Start. If you do not want to use the proposed folder, you can either
enter a new name, or select an existing folder from the list. Click Next and the Ready to
Install window will follow (Figure 1.7).
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8 TrackMaker01 Setup

~ You are now ready to install TrackMaker601 V2.00

The installer now has enough information to install Track Makerb01 an your computer

The following settings will be used:
Ingtall folder: C:\Program Files {(x86)" TrackMaker601

Shorteut folder:  TrackMakers01

Please click Mext to proceed with the installation.

s

| <Back | [ Neds | Conedd |

Figure 1.7: Ready to Install window

In case you would like to make any changes before the installation, click Back. To abort
installation click Cancel. If you are ready to start installation, click Finish. The instal-

lation progress bar will appear. The Installing Files window with a progress bar displays
the percentage of the installation completed. When finished, the following window will
appear (Figure 1.8).

08 TrackMaker601 Setup

Installation Successful
The TrackMakerbl1 V2.00 installation is complete.

Thank you for choosing TrackMaker&01!
Please click Finish to exit this installer.

Please visit us at http.//www.geomar.com .

= el

Cange!

Figure 1.8: Installing Files

Click Finish to end installation. SetupT601 creates a TrackMaker601 program group
and places TrackMaker601 and Uninstall icons into it. The setup program creates also
a TrackMaker601 menu item in the Program menu accessible by clicking Start. Installa-
tion procedure creates also shortcut TrackMaker601 icon on the Windows desktop. The
chosen destination directory contains program files and sample data files.

TrackMaker601 User’s Manual



1.4 Program Overview

Start the TrackMaker601 by double clicking the TrackMaker601 icon in the
Start | Programs menu, in Windows Explorer, or on the desktop if a shortcut was cre-
ated. At the start, TrackMaker601 displays the following screen (Figure 1.9):

B TrackMaker601

File Position Readings Cenvert Data Files  Data Transfer  Help

procassing NAVA01 data files
for Grods01-1 ond Grads -2

q

'Copwight © 2007-2021 Geomar Software Inc.

Figure 1.9:  TrackMaker601 Main Screen

The TrackMaker601 is a menu driven program. Most of menus items are disabled till a
data file is loaded in to the program. A short description of the possible menu options is
given below.

File Menu

The File Menu is shown in Figure 1.10. Functions accessible from this menu allow you to
load data file, to save data set, to save data set under different file name (Save As), to re-
move loaded data from the program memory (Close), to edit data parameters, to display
two dimensional layout of selected XYZ file, and exit the program.

When program starts most of items in File menu are disabled. As soon as data file is se-
lected and data is loaded to the program memory the splash graphic disappears and the
program displays information related to data file contents, Figure 1.11. At the same time
remaining items in the File menu are enabled.
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B TrackMaker601

Fllb Position Readings  Convert Data Files  Data Transfer  Help

Open File
Save
Save As
procassing NAVS0T datafiles
Close for Grodb01 -1 and Grods01-2

Edit Parameters
Display XYZ File

Exit

.Copyright © 2007-2021 Geomar Software Inc.

Figure 1.10: TrackMaker601 File menu

B TrackMaker601

File Position Readings Convert Data Files  Data Transfer  Help

210521_006 601
Created on 21/05/2021

r~ Local [Lagger) Tir ~ GPS Tir
Stated:  19:42:26.275 Stated:  23:50:54.43
Ended:  20:07:42728 Ended:  00:16:05.43

r Data File Contents ——————————————  ~ Diata File Settings
Grad601 Stations: 12822 Bartington Grade01-2
GPS Positions: 563 # of Sensors: 2 sensors
Invalid GPS Data: 1l Distance Urits:  meters
External Senzor Data: 0 GPS Message: GGA
Survey Lines: 1 GPS ¥ Offset: a
Cammerts: 0 GPSY Offset 5
Al zensors readings; 25644 Survey Mode: Auto
Fiducial Markers: 1] Ext.Sensor Type:  Mone
Sensors Separation [m]: 1 GPS Elevation:  Awailable

s

Figure 1.11: TrackMaker601 Main Screen after Loading data
file
TrackMaker601 does not allow to overwrite original data file. The Save option is en-
abled only when not original data file (i.e. with edited parameters or previously Saved
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As) was loaded or after option Save As was used. When original data file is selected the
name of the file and date of the creation is displayed at the top of the screen. In case
when not original file was loaded then the current file name is displayed, followed by an
original date of creation and original file name, for example: "Created on 06/02/2009 as
0602A.601".

The information displayed by the TrackMaker601 contains Local and UTC time, number
and type of Grad601 data points and GPS positions, number of survey lines, specified
distance units and GPS antenna offsets, etc. (see Figure 1.11). Four parameters: Number
of Grad601 sensors, Distance Units, GPS X and Y offsets can be adjusted using the Edit
Parameters item (see Figure 1.12).

[] Edit NAVEDT File Parameters  — O %
Parameter Ornginal from File Current Settings
Bartingtar: Grad&01-2

# of Senzors 2 Senzorz |2 Senzors VI
Digtance Urits: metkers meters vI

GPS = Offset ] 1]

GPS Y Offzet 5 ID?‘I

GPS offzetz are measured in corezponding Diztance U niks

from Eile Cancel | 0E. '\J
]

Figure 1.12: Edit Nav601 Parameters window

Position Readings Menu

The Position Readings menu represents the main function of the program: positioning
of the Grad601 sensor based on the system geometry and GPS positioning (Figure 1.13).

The first item of the menu, Position Readings Using NAV601 Data File allows you to
position sensors based on Real Time GPS data embedded in NAV601 file. Using GPS
data the program can also place elevation data in the output file.

The second item, Position Readings Using Grid Based Data File is used in case GPS
receiver positioning was not available and survey was positioned using layout grid (based
on stations and line numbers).

1.
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B TrackMakers01 - X
File Position Readings L\\)Convert Data Files Data Transfer Help
Positicn Readings Using NAVE01 Data Files

Position Readings Using Grid Based Data File

Created on 21/05/2021

r~ Local [Logger] Time ~ GPS Time
Stated:  13:42:26.275 Stated:  23:50:54.43
Ended:  20:07:42.728 Ended: 00:16:08.43

- Data File Contents ———————————— - Data File Settings
GradBO1 Stations: 12822 Bartington Grade01-2
GPS Positions: 563 H of Sensors: 2 sensors
Invalid GPS Data: 1l Distance Urits:  meters
External Sensor Data: 0 GPS Message: GGA
Survey Lines: 1 GPS ¥ Offset: a
Carrments: 1] GPS Y Offset 5
All zengors readings; 25644 Survey Mode: Auto
Fiducial Markers: 0 ExtSensor Type: Mone
Sensors Separation [m]: 1 GPS Elevation:  Awalable

Figure 1.13: TrackMaker601 Position Sensors menu

Convert Data Files Menu

The Convert Data menu has four functions available. The menu is shown in Figure 1.14.

The first item, NAV601 Files to ASCII Format allows you to convert data files to ASCII
text format. This file can be simply used to examine data in text mode, or it can be easily
converted to other formats if required.

The second item of the Convert menu, Retrieve and Position Field Comments allows
you to filter out and position field comments entered by the operator during the survey.

In case when the NAV601 program was used to acquire stand-alone GPS positions
(without EM data) the data files have extension name GXY. The third item, GXY File
to XY (ASCII) Format can be used to convert binary data file to simple text file with
two to four columns: Easting (Longitude), Northing (Latitude), and optionally Eleva-
tion (including correction for GPS antenna height) and Time Stamp of the record. These
files can be used in other applications, i.e. in mapping software to denote topographical
features as roads, fences, etc.. This option can be also used to convert any NAV601 data
file to a text file containing coordinates and elevation of GPS positions.

10
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T TrackMaker601 = X
File Position Readings = Convert Data Files  Data Transfer  Help
MNAVED1 Files to ASCIl Format
Retrieve and Position Field Comments
GXY File to XY (ASCII) Format
Correct Time Constant Delay in XYZ File

r Local [Lag
Stated:  19:42:26.275 Stated:  23:50:54.43
Ended:  20:07:42728 Ended: 00160543
r— Data File Contents ——————————————— ~ Data File Settings
Grad&01 Stations: 12@22 Bartington Grad&01-2
GPS Positions: BE3 # of Sensors: 2 sensors
Invalid GPS Data: 1l Distance Urits:  meters
External Senzor Data: 0 GPS Message: GGA
Survey Lines: 1 GPS ¥ Offsst: a
Camments: 0 GPSY Offsst 5
All zensors readings: 20644 Survey Mode: Buto
Fiducial Markers: 1] Ext.Sensor Type:  Mone
Sensors Separation [m]: 1 GPS Elevation:  Awvaiable

Figure 1.14: TrackMaker601 Convert Data menu

The last option of the Convert menu, Correct Time Constant Delay in XYZ Files can
be used to correct the effect of the system (combined Grad601 and GPS receiver) time
constant delay in two dimensional XYZ files generated during positioning Grad601 data.

Data Transfer Menu

This menu applies to older legacy Nav601 programs for DOS based handheld units, Win-
dows CE, and Windows Mobile field computers. All data files collected with Windows 7
or Windows 10 computer can be copied and pasted using standard Windows procedures,
and move files between computers using USB drives or network connection. The menu
has one item only and it is shown in Figure 1.15.

Transfer of files from Allegro CX (Windows CE.NET based field computer) or Windows
Mobile is handled by the MS ActiveSync program . Therefore the second item of this
menu displays information only (Figure 1.16).

Optionally, data files and program files can be transferred between Allegro CX and
other Windows Mobile computers by using PC or SD memory card. A PCMCIA card
slot is located behind the Allegro CX display (please see Allegro manual). Memory
card becomes a Storage Card in Allegro CX. Memory card is the fastest and easiest way

1.
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e, TrackMaker601

File Position Readings Convert Data Files

Data Transfer, Help

Download Logger Data Files

2105271_006.607

Created on 21/05/2021

r~ Local [Logger] Time

Started:  13:42:26.275
Ended:  20:07:42.728

 GPS Time

Started: 23505443
Ended: 00:16:08.43

r Data File Contents

Grad601 Stations:
GPS Positions:
Irvealid GPS Data
External Sensor Data:
Survey Lines:
Comments:

All senszors readings:
Fiducial Markers:

Sensors Separation [m]:

12822
563
n

0

1

0
25644
]

1

D ata File Settings
Bartington

# of Senzors:
Distance Units:
GPS Message:
GPS ¥ Offset:
GPS Y Offset
Survep Mode:
Ext.Senszor Type:
GPS Elevation:

Grade01-2
2 gensors
reters
GGA

]

5

Auta
Mone
Auvailable

Figure 1.15: TrackMaker601 Data Transfer menu

TrackMakerel1

e Please use M5 ActiveSync or memory card to transfer data files
b from Windows CE or Windows Mabile device

Figure 1.16: Windows CE and Windows Mobile data files
transfer i

of performing data transfer between Allegro CX (Windows CE) and Windows Mobile
devices and PC computer. In addition to data transfer, memory card can serve as a data

back up device during the survey

Help Menu

nfo

Item "About" is the only available option in this menu (Figure 1.17). It displays name
and version of the program, as shown in Figure 1.18. Help function is not available in

this version of the TrackMaker601.

12
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A detailed description of the function of each menus item is provided in relevant sections of the
manual.

T TrackMaker601

File Position Readings Convert Data Files  Data Transfer Helk

bout I
210521_006 6

Created on 21/05/2021

r~ Local [Lagger) Tir ~ GPS Tir
Stated:  13:42:26.275 Stated:  23:50:54.43
Ended:  20:07:42728 Ended: 00160543

r— Data File Contents ——————————————— ~ Data File Settings
Grad&01 Stations: 12@22 Bartington Grad&01-2
GPS Positions: BE3 # of Sensors: 2 sensors
Invalid GPS Data: 1l Distance Urits:  meters
External Senzor Data: 0 GPS Message: GGA
Survey Lines: 1 GPS ¥ Offsst: a
Comnmerts: o GPS ¥ Dffset R
All zensors readings: 20644 Survey Mode: Buto
Fiducial Markers: 1] Ext.Sensor Type:  Mone
Sensors Separation [m]: 1 GPS Elevation:  Awvailable

Figure 1.17: TrackMaker601 Help menu

& TrackMakerf01 - X

File Position Readings Convert Data Files  Data Transfer  Help

210521_006 601
Created on 21/05/2021

T About TrackMaker601
- Data Fi
-1 TrackMaker601
GPS _ s
. Version 2.00
Exte
- Geomar Software Inc. Iy
Co
All
Fiducial Markers: 1] Ext.Sensor Type:  Mone
Sensors Separation [m]: 1 GPS Elevation:  Awvaiable

Figure 1.18: About TrackMaker601 window
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File Menu

File menu of TrackMaker601 program is shown in Figure 2.1. There are several items associated
with the File menu:

*  Open File (loads NAV601 data file to the program memory),

» Save (saves data to the same file, disabled if original data file loaded),
* Save As (saves data to a file with different file name),

* Close (closes current data set),

e Edit Parameters (changes parameters in loaded data set),

* Display XYZ File (displays layout of stations in any XYZ file),

»  Exit (terminates TrackMaker601 program).

B TrackMakerf01

File Position Readings Convert Data Files Data Transfer Help

h Open File
Save
Save As
processing NaVs01 dota files
Close fior Grodé01-1 and Grodé01-2
Edit Parameters
Display XYZ File
Exit

—

e — e —

'Copyright © 2007-2021 Geomar Software Inc.

Figure 2.1: TrackMaker601 File menu

When program starts most of items in the File menu are disabled. They are enabled
automatically as soon as data file is loaded in to the program memory.

The general rule of the TrackMaker601 software is that the program cannot overwrite
original file name. In order to Save file, the original file name must be "Saved As" first.
The program tags such file and menu item Save is enabled. At further runnings when the
"Saved As" file will be loaded item Save will be enabled automatically.
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2.1 Open File

The Open File option allows you to load NAV601 data file to the program memory.
Select File | Open File from the main program menu, as shown in Figure 2.1. After the
selected menu item is clicked the Select NAV601 Input File window will be displayed in
the centre of the screen, Figure 2.2.

B Select NAV6OT Input File

4 || % Windows(C) > Data > TrméD1 > Mproject v o 2 Search Mproject
Organize ¥ New folder =~ M @
A Neme Date modified Type @
# Quick access
[ 210521_000.601 7:31PM 601 File
OneDrive [E] 210521_001.601 601 File
—— = 210521_002.601 801 File
- [Zl 210521_003.601 601 File
1 30 Objects = i
[E] 210521_004.601 601 File
I Desktop [ 210521_005.601 601 File
|5 Documents [Zl 210521_006.601 601 File
4 Downloads [E 210523_000.601 601 File
b Music B 210602_000.601 601 File
= Pictures [E] 210602_001.601 601 File
I videos =) 210603_000.601 601 File
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Figure 2.2:  Select NAV601 Input File window

The window lists files with extension name 601. Select a file name and click the Open
button. The Select NAV601 File window will close and the progress bar will appear in
the center of program’s main window indicating percentage of loaded file (Figure 2.3).

As soon as data file is selected and data is loaded to the program memory the splash
graphic disappears and the program displays information related to data file contents. At
the same time remaining items in the File menu (and items in other menus as well) are
enabled and the Open File item is disabled.

The TrackMaker601 main window displays the most important parameters of the
entered data file (Figure 2.4). At the top of the window the current file name, date of
file and optionally original file name (as entered in the field), and start and end times

in local time (field computer clock) and UTC time (GPS time in NMEA messages) are
displayed. Below, in the left window frame labeled Data File Contents a total number of
Grad601 readings, number of GPS positions recorded, number of invalid GPS positions
(with not valid checksum), number of survey lines, comments, and number of used fi-
ducial markers in the field are given. In the right frame labeled Data File Settings listed
are: the Grad601 Type - number of sensors, type of used GPS NMEA message, GPS X
and Y offsets (in Distance Units), and survey mode.
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Figure 2.3:  Progress bar indicating loading the NAV601 file
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Figure 2.4:  TrackMaker601 Main Screen after data file is loaded

9. File Menu
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When original data file is selected the name of the file and date of the creation is dis-
played at the top of the screen. In case when not original file was loaded then the current
file name is displayed, followed by an original date of creation and original file name, for
example: "Created on 02/03/2008 as 020310A", (see Figure 2.5).

At this point loaded data can be used for further data processing.

2.2 Save, Save As, Close

As it was mentioned data can be saved only if the data file was previously Saved As. This
assures that the original data file will not be overwritten, i.e. with edited parameters. The
File menu item Save is enabled only when other than original data file is loaded. The
indication that file was previously Saved As is given at the top of the screen, under cur-
rently loaded file name label "Created on 03/06/2021 as 210603_000" provides informa-
tion that the original file name was 210603_000.601 (Figure 2.5). Otherwise this label
would provide only date of the created file (see Figure 2.6).

P TrackMaker601 — x
File Position Readings Convert Data Files Data Transfer Help
Open File
N Save SiteM_0606.601
S2Els Created on 03/06/2021 as 210603_000
Close
] ~ GPS Time
Edit Parameters 51:09.954 Started:  20:01:02.43
Display XVZ File 26:04.704 Ended: 20:35:54.43
Exit D ata File Settings
GradB01 Stations: a7 Bartington Grade0l-2
GPS Positions: 381 # of Senzors: 2 gensors
Irvealid GPS Data 0 Distance Unitz: ~ meters
External Sensor Data: 0 GPS Message:  GGA
Survey Lines 2 GP'S ¥ Offeet: o
Comments: 1 GFS ¥ Offset 4
All senszors readings: 16342 Survey Mode: At
Fiducial Markers: a Ext.Sensor Type: Mone
Sensars Separation [m]: 1 GPS Elevations  Avaiable

Figure 2.5:  TrackMaker601 Main Screen with item Save enabled
after not original file was loaded

The File menu item labeled Save As allows you to save any data set. Select File | Save As
from the program main menu (see Figure 2.6). After the selected menu item is clicked,
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File Position Readings Convert Data Files Data Transfer Help

Open File

Save 210603_000.601

Savelis Iy Created on 03/06/2021

Close
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Edit Parameters 51:09.954 Started:  20:01:02.43

Display XYZ File 26:04.704 Ended: 20:35:54.43

Exit D ata File Settings
GradB01 Stations: a7 Bartington Grade0l-2
GPS Positions: 381 # of Senzors: 2 gensors
Irvealid GPS Data 8 Distance Unitz: ~ meters
External Senzor Data: 0 GPS Message:  GGA
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Comments: 1 GPS Y Offset 4
All sensors readings: 16342 Survep Mode: Autg
Fidugial Markers: 0 ExtSenzor Type: Mone
Sensors Separation [m]: 1 GPS Elevation:  Available

Figure 2.6:  TrackMaker601 Screen with loaded original data file,
disabled Save option, and selected Save As item

the Save As NAV601 Input File window will be displayed in the centre of the screen,

[ Save AsNAV6D1 Input File X
4 [« Windows (C) > Data » Tm60l » Mproject v O £ SearchMproject
Organize v New folder =~ @
Onebrive A Name - Date modified Type si ™
[ 210521_000.601 601 File
[ This PC
= This
= [E 210521 001601 601 File
3D Objects [ 210521_002.601 601 File
I Desktop. [ 210521_003.601 601 File
Documents [ 210521 004601 601 File
& Downloads [B 210521 005601 601 File
D Musie [ 210521 006601 601 File
=] Pictures 5 210523_000.601 601 File
S 210602_000.601 601 File
B Videos
. g 210602_001.601 601 File
£ TS e [ 7106m 000 A A1 Fils. v
v o< >
File name: | SiteM_060¢ -
Saveastype: | NAVGD1 Files (601) v
~ FideFods Cone
[

Figure 2.7:  Save As NAV601 Input File dialog

This option is especially useful in faster file loading. Windows system creates files that
are not always organized according to time stamp sequence, also GPS records can be
inter-spaced by Grad601 readings. When such file is loaded, first it is sorted by the
program. The option Save As will save data in organized format, and therefore loading
previously saved file will be faster (since sorting is not necessary). The TrackMaker601
recognizes sorted files automatically.
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After the file is saved with Saved As option the Main Screen of TrackMaker601 will be
updated, and file name will placed at the top of the screen and the item Save in the File
menu will be enabled, Figure 2.8 (compare with Figure 2.6).

B TrackMaker601 _ X

File Position Readings Convert Data Files Data Transfer Help

SiteM_0606.601

Created on 03/06/2021 as 210603_000

r Local [Logger) Time ~ GPS Time
Started:  15:51:09.954 Started:  20:07:02.43
Ended:  16:26:04.704 Ended: 20:35:54.43
- Data File Contents ———————— [~ Data File Settings
GradB01 Stations: a7 Bartington Grade0l-2
GPS Positions: 381 # of Senzors: 2 gensors
Irvealid GPS Data 8 Distance Unitz: ~ meters
Extemnal Senzor Data: 0 GPS Message:  GGA
Survey Lines 2 GPS ¥ Offeet: 1]
Comments: 1 GPS Y Offset 4
All sensors readings: 16342 Survep Mode: Autg
Fidugial Markers: 0 ExtSenzor Type: Mone
Sensors Separation [m]: 1 GPS Elevation:  Awvailable

Figure 2.8: TrackMaker601 Main Screen after completed
Save As option

Clicking on the Close item in File menu will remove data set from the program memory,
the Main Screen will display splash graphic and the menu item Open File will be en-
abled. This action allows you to load another NAV601 data file.

2.3 Edit Parameters

Four parameters entered during the field work can be modified during data processing.
Click on the Edit Parameters item in the File menu and the Edit NAV601 File Param-

eters window will appear (Figure 2.9). The Edit Parameters window is also available in

Position Readings options.

The window displays parameters that the user can edit. These are: Grad601 Type
(number of sensors), Distance Units, and GPS X and Y offsets. If all parameters were
correctly specified in the field then clicking on OK or Cancel button will accept these
entries. In case some of the parameters require modification they can be entered in ap-
propriate text boxes located under label Current Settings. Instrument Type and Distance
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[I[] Edit NAVEDT File Pararneters  — O

Pararneter Original fram File  Current Settings

B artington: Grade01-2

# of Sensors 2 Sensars |2 Sensors "I
Distance Urits: meters meters ﬂ

GPS ¥ Offzet 0 1]

GPS v Offzet 4 |_4

GPS offzets are measured in comezponding Distance niks

from File cancel | [[TEK

Figure 2.9:  Edit NAV601 File Parameters
window

Units can be selected from combo list boxes, while GPS X and GPS Y offsets must be
entered in appropriate text boxes. Example of NAV601 File Info window with modified
parameters is shown in Figure 2.10.

[I[] Edit NAVEDT File Parameters  — O
Pararneter Original fram File  Current Settings
B artington: Grade01-2

# of Sensors 2 Sensors |2 Sensors "I
Distance Units: meters meters vl

GPS & Offset 0 0.4

GPS v Offset 4 |_4

GPS offzety are measured in comezponding Distance Units

frDmEiIel Cancel | QK N

Figure 2.10: Modified parameters in Edit
Parameters window
Clicking on the OK button will accept any changes, clicking on the Cancel button will
cause the program to use initial parameters (state when window was displayed), while
clicking on the button from File will change parameters to original values (listed in fields
under label Original from File). After the buttons OK, Cancel or from File are clicked
the Edit NAV601 File Parameter will disappear.
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Any updates in this window are valid only for duration of the program. The data file will
remain the same unless it Saved or Saved As in File menu.

2.4 Display XYZ File

The Display XYZ File option allows you to display two dimensional layout of stations
in a selected XYZ file. Select File| Display XYZ File from the main program menu, as
shown in Figure 2.1. The Select XYZ to Open window will appear.

The window lists files with extension name XYZ. Select a file name and click the Open
button. The Select XYZ to Open window will close, the file will be loaded and two di-
mensional image will be displayed (Figure 2.11).

The image displayed in the Plot XYZ window shows the spatial layout of stations to
scale, based on the station coordinates as written in the selected XYZ file.

Figure 2.11: Two dimensional layout of stations in XYZ File
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Position Readings

Positioning of the Bartington Grad601 sensors is the main function of the TrackMaker601. Loca-
tion of the magnetic sensor is calculated based on the recorded GPS position, instant heading

of the system, and the system geometry which is described by the location of GPS antenna. Grid
based positioning is described in a separate document: GridPositioningNotes.pdf

Description of functions involved in positioning the Grad601 is preceded by a short description
of the system geometry.

3.1 The NAV601 System Geometry

The GPS antenna can be placed anywhere in relation to the instrument center. However
to achieve the highest possible accuracy of the calculated positions the GPS antenna
must be placed as close to the center of the system as possible.

If one sensor is used (Grad601-1) the natural center of the system is the center of the
sensor (Figure3.1), and the best and optimal placement of the GPS antenna is located
above the center of the Grad601 sensor. In case of Grad601-2, when two sensors are
employed, the center of the system is located between two sensors, Figures 3.2 and 3.3.
The optimal placement of GPS antenna is in the central position between two magnetic
Sensors.

When a survey is positioned by GPS system and GPS antenna can not be placed in the
center point of the instrument the program allows to specify the GPS antenna offset
from the Grad601 sensor center. Two parameters, GPS X Offset and GPS Y Offset
describe location of GPS antenna. This location is represented by the distance which is
measured from the center of the Grad601 system (reference point 0,0) to the center of
the GPS antenna, while facing direction of the movement, see Figures 3.1, 3.2, and 3.3.

When two sensors are used there is a difference in description of sensors positions. In
the Nav601 for Windows Mobile sensors locations are specified by offsets from reference
point 0,0 (Figure 3.2), while in the Nav601 for Windows 10 a parameter Separation in-
dicates distance between sensor and reference point 0,0 is located in the center between
sensors (Figure 3.3).

Therefore, when two sensors are used in the Windows Mobile data acquisition program
Nav601, there are two additional parameters, offsets for each sensor. Sensor #1 is locat-
ed to the left, and Sensor #2 is located to the right while facing direction of movement.
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Figure 3.1:  The Grad601 and GPS antenna geometry for one
sensor setup.
Offsets for sensor 1 and 2 can be specified while creating XYZ file, they are measured
from the center of the system as offsets for GPS antenna (Figure 3.2). If the Nav601 for
Windows 10 is used to collect data then Separation describes distance between sensors
and reference point 0,0 is assumed to be in the center between two sensors (Figure 3.3).

The procedure of specifying GPS antenna X and Y offsets in relation to the direction of
the system movement is very important and should be maintained during data collection
for the entire data file. Therefore, the operator can not walk few steps or drive back-
wards without changing data file name. If it is necessary data logging must be paused for
the time of such movement since positioning of the sensor based on GPS is based on
this assumption.

This option is provided mainly for situations where the operator carries the Grad601,
and GPS antenna (placed in backpack) is located above his shoulder. In this case dis-
tance between GPS antenna and the instrument (GPS X Offset) is relatively small (less
than 0.5 m), and GPS Y Offset will be usually very small as well and its sign will depend
on whether the center of the instrument is in front (negative) or behind the GPS anten-
na (positive). This situation corresponds to the system geometry presented in Figure 3.1.

As it was mentioned earlier, the best placement of the GPS antenna is located above the
center of the Grad601 sensor. In case where the GPS antenna is located in front of the
electromagnetic sensor the GPS Y Offset is positive, and if the GPS antenna is located
behind the instrument the GPS Y Offset is negative.
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Figure 3.2:  The Grad601 and GPS antenna geometry for two
sensors setup used in the Nav601 for Windows Mobile
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Figure 3.3:  The Grad601 and GPS antenna geometry for two
sensors setup used in the Nav601 for Windows 10
In the case where a wrong value was entered in the field, GPS X Offset and GPS
Y Offset parameters can be corrected later during data processing in the program
TrackMaker601.

3. Position Readings
e Grad601 and GPS antenna geometry
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In general, when GPS antenna is located off the center of the system positions of the
instrument will be calculated based on the GPS antenna position and instant heading. In
order to achieve higher quality of data positioning the survey should be carried out along
relatively smooth pathways, especially if GPS antenna is located further from the center
of the instrument.

When the direction of the survey line is changed it is advised to pause recording of data
for the duration of U-turn. Toggling between Stand By mode (pause) and Log mode is
relatively easy in the most difficult field conditions, it is done by one key stroke (Pause
and Start keys), and it can save time during data processing.

Similar approach applies to situations when the system is stopped. In this case if readings
are not paused, the random distribution of small GPS errors will likely result in unreli-
able locations of calculated sensor positions. If the offset of GPS antenna is used it may
appear that the instrument is rotating since GPS errors occur in many directions. Paus-
ing readings while the system is stopped will save time during data processing and will
result in better data presentation.

3.2 Positioning Readings Using NAV601 Data File

After a data file is loaded the TrackMaker601 main window displays the most important
parameters of the entered data file (Figure 3.4). At the top of the window the current
file name, date of file and optionally original file name (as entered in the field), and start
and end times in local time (field computer clock) and UTC time (GPS time in NMEA
messages) are displayed. Below, in the left window frame labeled Data File Contents

a total number of Grad601 readings, number of GPS positions recorded, number of
invalid GPS positions (with not valid checksum), number of survey lines, comments,
number of readings, and number of used fiducial markers in the field are given. In the
right frame labeled Data File Settings listed are: type of the instrument, units, type of
used GPS NMEA message, and GPS X and Y offsets (in Distance Units).

The Position Readings Using NAV601 Data option allows you to position Grad601 sta-
tions based on Real Time GPS data which were recorded in NAV601 data file during the
survey. Select Position Sensors | Position Readings Using NAV601 Data Files from the
main program menu, as shown in Figure 3.4. The second item Position Readings Using
Grid Based Data Files can be used when survey was positioned using grid layout on the
ground, this option is described in a separate document: GridPositioningNotes.pdf.

After the selected menu item is clicked the Position Grad601 Readings Using NAV601
Data File dialog will be displayed in the centre of the computer screen, Figure 3.5.
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Figure 3.4: Position Readings menu

Parameters in Positioning Readings Using NAV601 Data File Window

Several parameters which affect the contents and format of the created output (XYZ)
file must be specified. These are the XYZ output file name, parameters describing
contents and format of the created file and parameters related to magnetic as well as to
GPS data.

Edit Parameters

The TrackMaker601 main window (Figure 3.3) displays the most important
parameters of the entered data file. In case some parameters were wrongly en-
tered in the field it is possible to change them using Edit Parameters option (the
same option is available in the File menu of the TrackMaker601 main screen).
Click on the Edit Parameters button and Edit NAV601 File Parameters window
will appear (Figure 3.6).

The window displays parameters that the user can edit. These are: number of
the Grad601 sensors, Distance Units, and GPS X and Y offsets. If all param-
eters were correctly specified in the field then clicking on OK or Cancel button
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Figure 3.5:  Position Grad601 Readings Using NAV601 Data
File window

will accept these entries. In case some of the parameters require modification
they can be entered in appropriate text boxes located under label Current Set-
tings. Number of sensors and Distance Units parameters can be selected from
combo list boxes, while GPS X and GPS Y offsets must be entered in appropri-
ate text boxes. Example of NAV601 File Info window with modified parameters
is shown in Figure 3.7.

Clicking on the OK button will accept any changes in parameters, clicking on
the Cancel button will cause the program to use initial parameters (state when
window was displayed), while clicking on the button from File will change pa-
rameters to original values (listed in fields under label Original from File). After
the buttons OK, Cancel or from File are clicked the Edit NAV601 File Param-
eter will disappear.

Any updates in this window are valid only for duration of the program. The data
file will remain the same unless it is Saved or Saved As in File menu.
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Figure 3.6: Edit NAV601 File Parameters dialog
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Figure 3.7:  Modified parameters in Edit
Parameters dialog
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Output File

Click on the Output XYZ File button. The Select Output File window is dis-
played (Figure 3.8).

[ Select Output File
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XVZ File 1,027 KB

[ This PC
B 30 Objects

File nome: [ 210521 006 meter] -

Save astype: | XVZ Files (*xyz) v

A HideFolders Conc
Figure 3.8:  Select Output File dialog

Select a file name and click the Save button. The Select XYZ File window will
close and the selected file name will be displayed beside the Output XYZ File
button in the Position Grad601 Readings Using NAV601 File window.

When Output file is specified the Proceed button in the Position Grad601 Read-
ings Using NAV601 File becomes active (Figure 3.9).

Creating XYZ File Options

These options apply only of Grad601-2 (2 sensors) is used. Data can be written
to one file when option Create One File is checked, or to separate files for each
sensor if the option Separate Files is checked. Both options can be used at the
same time.

If One File is selected, data set for the Sensor #1 is written first and data set for
the Sensor #2 follows.

Select Grad601 Data in XYZ File

To select specific or both Sensors data click on corresponding check buttons
labeled Probe #1 and Probe #2. This section is also used to specify offsets

for each sensor. As described in the former section, Sensor #1 (Probe #1) is
located on the left side and Sensor #2 (Probe #2) is located on the right side of
the system center while facing direction of movement (see Figures 3.1 and 3.2).
Units for sensors offsets are labeled on the right side and they depend on the
selection specified in the System Setup dialog.

TrackMaker601 User’s Manual



[ Position Grad&01 Readings Using NAVEDT File b4

Output 277 File | IC:\Data\TrmBD‘I\Mproiect\21DSZ‘I_DDB_meters.:-c_l,lz

— Type of Dutput File
® Geneic ( Geosoft ¢ Line

Edit Parameters Beplat Last Output File

Creating ¥vZ File Options—————— ~ Fomat [Column D elimiter)
’7 V¥ Create OneFile [ Separate Files ® Fised [Spaces] CS5W
— Output Coordinates [wWGE584) [~ Select Grad801 Data in =YZ File

o + —Format————————————————— ¥ Probe #1 Offset [ 5 m

# DDD.DDDDODDD I~
v Piobe 2 Dffset [5
 DDDMM.MMMMM e =la

©UTM — Unit:

—Select Optional D ata

IMeters v[ W Elevation ¥ GPSAC W Time

125 &m R

— Time uged during sensors positioning

[~ Use UTC time for uriform distribution (recommended for sensor update rate > 5 Hz)

—GPS Time Gap —GPS Minimum Interval—— — G54 Message Include in File
& meters ; ¥ Header Info
|5 seconds 0.0z [T Dizable
" feet —‘ ’7 ¥ Field Comments
~ PDOP Mask — Corrections————— ~Position Mode

&30 valid anly for

[+0° GEAsGSA it 0575 <] Pr
Differertial [DGPS) P ‘“ﬁ’

¥ Positive Only

LCancel | E xit |

Figure 3.9:  Position Grad601 Readings Using NAV601 Data
File window

Sensors Offsets option are left as a legacy approach for Windows Mobile

based Nav601 programs users, these programs do not have entry for sensors
location during measurements and it is the only place to specify locations of
sensors. For users of Windows 10 based data acquisition program Nav601 the
TrackMaker601 automatically divides Separation and displays them as two
offsets. For example if Separation was specified as 1 m then both offsets will be
shown as 0.5 m (-0.5 and +0.5). In most cases it is just default option, however
if need will arise and Separation is to be adjusted (or if asymmetrical sensors
placement was used) then offsets entered in this dialog will be taken to account
during XYZ file preparations.

Please note that while Sensors Offsets and GPS Antenna Offsets have the same
reference point (center of the system), they do not depend on each other.
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Select Optional Data

Three optional data can be written in the output file. These are Elevation, GPS
QC parameters (Quality Indicator, PDOP or equivalent, number of satellites),
and Time Stamp for each reading. To select optional data click on the check box
next to the corresponding name.

If the check box labeled Elevation is clicked (checked) then a text box labeled
Antenna Height and two radio buttons labeled m and ft become active. The

text box labeled Antenna Height allows you to enter correction for Elevation
data. The Antenna Height corresponds to the distance between ground surface
and GPS antenna. If Antenna Height is set to zero then elevations for the GPS
antenna (not the ground surface) are written to the output file. Two radio but-
tons labeled m (meters) and ft (feet) allows you to specify units for elevation
data placed in the output file. It is assumed that Antenna Height parameter is
entered in units specified by these radio buttons.

Elevation values base on the recorded GPS data. Therefore Elevations will not
be written to the file if the NMEA message GLL was used during the survey.
Message GLL does not contain elevation data.

When the check box labeled GPS QC is checked the file will contain GPS signal
quality parameters: correction quality indicator (AGPS, DGPS, RTK, etc.),
PDOP or HDOP (depending on NMEA statement) values, and number of sat-
ellites used to calculate position.

In case RTS SLAM pseudo-GGA messages were used during data collection the
GPS QC option will be replaced by a check box labeled SLAM, when available
and checked the created file will contain four RTS SLAM parameters: SLAM
Confidence, Pitch, Roll, and Yaw.

If check box labeled Time is checked then XYZ will contain local time and data
points will be interpolated between GPS points based on local time stamps. This
parameter can be overwritten by UTC Time option, described below.

Data is always placed in the created XYZ file in the following order: X coor-
dinate (Easting or Longitude), Y coordinate (Northing or Latitude), Grad601
sensor as selected (if both sensor are selected then Sensor #1 data set is written
in the first half of the XYZ file and the Sensor #2 data set follows), Elevation,
three GPS QC parameters (Quality Indicator, PDOP or equivalent, Number of
Satellites), and Time Stamp.

If parameter Header Info in Include in File section is checked a line listing all
parameters in the file will be placed as a header for each created XYZ file.

Use UTC Time for Uniform Distribution

When this option is checked Grad601 sensor readings time stamps will be re-
placed by uniformly distributed time stamps based on UTC recorded in neigh-
bouring GPS positions. At the same time, if option Time (indicated in Select
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Optional Data section) is enabled time stamps in created XYZ file will contain
UTC time.

This option can be used when UTC time in XYZ files is needed or if very uni-
form data spacing is required. Windows timer has limited resolution and at high
rates (above 10 Hz) data can be not spaced very uniformly by Windows timer.

Type of Output File

Check the option appropriate for the contouring software used. The Generic
option will create three or more column file without any text strings. This file
can be used as an input file for many contouring packages (including Surfer).
Geosoft format will cause the program to write LINE # at the beginning of each
survey line. A Line format has specific format (please see example in Appendix)
for some archaeological software packages.

Format (Column Delimiter)

Check an option labeled Fixed or CSV appropriate for the mapping or other
software used. The Fixed (Spaces) will format aligned columns spaced by a
number of spaces. The CSV (Comma Separated Values) will divide columns
by a single comma. The latter format is also suitable to be used with Excel and
other programs.

Include in File

This section contains two check boxes labeled Header Info and Field Com-
ments. When Header Info box is checked the file will contain a header listing
type of coordinates and names of data contained in each column of created
XYZ file. Checking box labeled Field Comments will cause the program to
write text of all field comment (entered by the operator during the survey) in to
the created file.

Output Coordinates

Positions can be written in the output file as geodetic (geographical) coordinates
(Latitude/Longitude) or they can be converted to UTM coordinates. The pro-
gram uses the WGS1984 datum. To select coordinates click Geodetic or UTM
radio buttons (Figure 3.9).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can be
written in two formats DD.DDDDDDDD or DDMM.MMMMM (native for-
mat found in NMEA GPS messages). To select which format click the appropri-
ate radio button in Format section located at the radio button labeled Geodetic.
This section is active only when radio button Geodetic is selected (Figure 3.9).
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UTM coordinates can be generated in meters, feet, or US Survey feet. To select

units for UTM coordinates select proper parameter from the combo box located
in the Units section located at the UTM radio button (Figure 3.10). This combo

box is active only when radio button labeled UTM is selected.

GPS Time Gap

Differentially corrected GPS data often has gaps, due to differences in the con-
stellation of satellites visible to two (fixed and moving receivers), lack of beacon
signal, surveying near trees, buildings, and other elevated obstructions. These
gaps are filled by TrackMaker601 with the assumption that the GPS receiver
speed is essentially constant and that it moves along a straight line during the
gaps.

The GPS Time Gap parameter specifies the maximum time during which the
Grad601 data will be linearly interpolated between two GPS positions. Enter
this parameter (in seconds) in the edit box labeled seconds in the GPS Time
Gap section (Figure 3.10). In most cases a value 2 to 3 times larger than the
GPS data acquisition frequency is adequate, however the user has to determine
this value based on the survey specific conditions and requirements. To ignore
effect of this parameter enter a large number of seconds (i.e. 300 or more) as
GPS Time Gap parameter.

GPS Minimum Interval

The GPS Minimum Interval parameter specifies the minimal distance between
two GPS stations that will be used in interpolation. If this distance is smaller
than the specified GPS Minimum Interval, then all Grad601 readings located
between these two stations will be ignored. This parameter is useful in cases
when the operator stops for a moment and data are collected in one point.
Limited accuracy of GPS positioning will create randomly distributed positions
in area adjacent to the stationary location of the system. If TrackMaker601 will
calculate positions of sensor in case offset values (GPS X and/or GPS Y Offsets)
are different than zero, positions of the Grad601 will have quite large varia-
tions associated with apparent change of direction of the survey line caused by
randomly close spaced GPS positions. In most cases a value 2 or 3 times smaller
than average distance between two GPS stations is adequate, however the user
has to determine right value for this parameter which will depend on survey
conditions and first of all accuracy of the employed GPS receiver. To ignore the
effect of this parameter and to use all stations during creating XYZ file (i.e.
during testing when GPS antenna is stationary) set this parameter to zero.

Enter the GPS Minimum Interval in the edit box and check one of the two radio
buttons labeled meters and feet (indicating distance unit) in the GPS Minimum
Interval section (Figure 3.10).
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[ Position Grad&01 Readings Using NAVEDT File

Edit Parameters

Beplat Last Output File
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Figure 3.10: Position Grad601 Readings Using NAV601 Data

GSA Message

File window

This parameter is used to disable GSA message. This is to be used only if the
operator has specified in the data acquisition program (NAV601) that the GPS

Message will be pair GGA/GSA and for any reason message GSA was not

recorded. In such case the TrackMaker601 will search for GPS quality informa-
tion contained in not recorded GSA statement and it would conclude that GPS
readings are invalid. Disabling GSA message in this situation causes that the

program will use only information available from GGA message.

PDOP Mask

The PDOP Mask is used to filter quality of GPS positions. The index called
PDOP (Position Dilution of Precision) measures the strength of satellite cover-
age for a given area. PDOP is affected by the number of satellites visible and
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their relative positions in the sky. The smaller the number of PDOP the stronger
the satellite coverage is. When there are more than 5 satellites widely spaced
visible, the PDOP is 4 or less. However, when there are less satellites visible, or
they are unevenly spaced in the sky, PDOP values can be 6 or higher. In most
cases, the PDOP in open sky is less than 3, and most accuracies given for many
GPS systems are given for this norm. The index called GDOP covers time accu-
racy in addition, while the index HDOP is related only to horizontal position fix
(it is used when message GGA was selected). Refer to GPS documentation and
literature for more information related to error sources of GPS positioning.

The section PDOP Mask may differ depending on GPS NMEA message used. It
is related to PDOP parameter if GGA/GSA, POS, or GGK was employed dur-
ing the survey, to HDOP if GGA was used, to GDOP if LLK was used during
the survey, and it is invalid if GLL or LLQ message was used.

Enter the PDOP (HDOP or GDOP) value in the edit box in the PDOP Mask
section, Figure 3.10. All positions (as well as Grad601 readings) associated with
GPS data of higher than specified value of this index will be ignored.

Corrections

Select type of differentially corrected position data to be used during the cre-
ation of XYZ file in the combo list box labeled Corrections. Four types of GPS
corrections are given: Raw (GPS), Differential (DGPS), Differential (RTK 3),
Differential (RTK 4), and Differential (RTK 5). Last three types of RTK (real
time kinematic) corrections are available only in high end of GPS receivers and
differently named depending on manufacturer, however in NMEA specifica-
tions they indicate Quality Parameter 3, 4, and 5. When Raw is selected, both
differentially corrected and raw GPS data are used to calculate positions of
Grad601 stations.

Position Mode

This option is valid only if the pair GGA/GSA messages were used during data
collection. If radio button labeled 3D is checked then GPS data in mode 3D are
used, while when radio button 2D is checked then program uses 2D as well as
3D mode of GPS data.

It should be noted that if any NMEA message indicates that GPS position (fix) is invalid
this data is ignored by the TrackMaker601.
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Creating XYZ Files With Positioned Readings

When all parameter are set and output file name is specified, the Proceed button is acti-
vated in the Position Readings Using NAV601 File window. After you click the Proceed
button, the program begins to filter loaded data, calculates Grad601 stations positions
based on the recorded GPS readings, instant heading, and other specified parameters,
and writes results to the XYZ output file. A progress bar at the bottom of the screen
shows the percentage of the file processed (Figure 3.11).

osition Gra eadings Usin ile
Position Grad@01 Readings Using NAVG01 Fil

Qutput =77 File | IE:'\Dala\TrmEm\Mproiect\210521_DDB_rnelers.x_l,lz
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’7 V¥ Create One File [ Separate Files ' Fived [Spaces) [l -t
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Figure 3.11: Position Grad601 Readings Using NAV601 File

window during creating

Z file

The speed of this operation depends on the size of the input file. After the output XYZ

file is created a two dimensional layout of the survey is displayed (Figure 3.12).

The image displayed in the Plot XYZ window shows the spatial layout of stations to
scale, based on the station coordinates as written to the created file. The display has
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Figure 3.12: Two dimensional I%/out of stations taken with the Bartington Grad601-2. The GPS

X =0 and GPS Y offsets was set to 0.5 m (GPS antenna was located 0.5 m ahead of
the center of the Grad601 system), and Sensors Separation 1.0 m or for Windows
Mobile - Sensor Offsets were -0.5 m for Sensor #1 (red dots) and 0.5 m for Sensor
#2 (blue dots).

fixed colours. GPS positions are marked by larger grey dots while the Grad601 Sensor
#1 stations are plotted by smaller red dots and Sensor #2 positions are indicated by
small blue dots. This plot window can be closed by clicking on Clese button (located in
the top right corner of the window).

After the Plot XYZ window is closed a button Replot Last Output File becomes ac-

tive and the layout of data can be examined again. However, at this time original GPS
positions will not be displayed and only instrument positions will be represented by red
dots on the screen. Files created by this portion of the program can be also viewed at any
time using the File |View XYZ File menu.

After the file is created and its layout is examined it is possible (if required) to recreate
XYZ file with changed system geometry parameters. To do this, click Edit Parameters
button, the Edit NAV601 File Parameters window will appear as shown in Figure 3.13.
After changes are done, click the Proceed button to repeat procedure of creating XYZ
file. See example in Figure 3.14 where GPS antenna location was changed as compared
to case shown in Figure 3.12.

38
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[I[] Edit NAVED1 File Parameters  — |

Parameter Original from File  Current Settings

Bartington: Grade01-2

# of Sensars 2 Sensors 2 Sensors 'I
Distance Units: meters meters vI

GPS X Offset 0 .3
GPS ' Offset 5 |1|

GPS offzets are measured in conesponding Disﬁnce Uitz

fram File | Cancel | Ok |

Figure 3.13: Edit Parameters dialog

Figure 3.14: Two dimensional layout of stations taken with the Bartington Grad601-2. The GPS
X Offset was 0.3 m and GPS' Y Offset was set to zero, and Sensors Offsets were -0.5
m for Sensor #1 (red dots) and 0.5 m for Sensor #2 (blue dots) or Z/or Windows 10

based Nav601 Separation was 1 m. Therefore GPS antenna was located closer to
Sensor #2.

If the input file does not contain sufficient GPS information, or parameters are not
correctly selected, the program will display a warning message (Figure 3.15), and the
program will pause operation till the OK button is clicked in the warning window.
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TrackMakerb01

Mo instrument readings,
LE check file content and parameters settings: GPS Time Gap, GPS
Minimum Interval,
and instrument Data Selection in dialog. GPS positions will be
plotted only,

This message may indicate lack of GPS data in the file, however in most cases it reflects
lack of GSA messages when GGA/GSA was selected in the data acquisition program
(check Disable GSA Message), raw positions only when Differential button is checked,
or too critical (too small) value specified in GPS Time Gap section, unchecked both
Grad601 channels specified in Select Data section, etc..

Figure 3.15: Warning window

40
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Convert Data Files

Convert menu of TrackMaker601 program allows you to convert the NAV601 binary file to other
formats. There are four items associated with the Convert menu (Figure 4.1):

e convert NAV601 file to general format ASCII file,

* retrieve and position field comments from NAV601,
¢ convert GXY file to ASCII file containing positions,
*  correct system time constant delay in XYZ files.

B TrackMaker601

File Position Readings Eémvert Data Files Data Transfer Help
MNAVEDT Files to ASCI Format
Retrieve and Position Field Comments
GXY File to XY (ASCIl) Format
. . data files
— Correct Time Constant Delay in XYZ File Erodsnl -2

607

Copyright © 2007-2021 Geomar Software Inc.

Figure 4.1:  Convert Data Files menu

Files converted to general ASCII format can be easily reformatted and used by other software.
While retrieving comments from NAV601 file, the program retrieves text of the comment and
their position based on neighbouring GPS records. When converting GXY files (containing only
GPS positions and field comments) the program generates simple XY type of file (coordinates in
two columns with optional parameters). Correct Time Constant Delay item provides correction
for specified time constant delay of the system (EM instrument specific time constant combined
with GPS latency). Any XYZ file containing sequential time stamp column can be corrected
while using this option.
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It should be noted that three first items of Convert Files menu are disabled. They are enabled
automatically after the NAV601 data file is loaded in File menu (Figure 4.2).

T TrackMaker601 = X
File Position Readings = Conwvert Data Files  Data Transfer Help
MNAVEDT Files to ASCII Format
Retrieve and Position Field Comments
GXY File to XY (ASCII) Format
Correct Time Constant Delay in XYZ File

Local [Log,
Stated:  19:42:26.275 Stated:  2350:54.43
Ended:  20:07:42728 Ended: 00:16:08.43
—Data File Contents —————  ~DataFile Settings
GradBO1 Stations: 12822 B artington Grade01-2
GPS Positions: 563 # of Sensors: 2 sensors
Inwalid GPS Data: I Distance Urits:  meters
External Senzor Data: 0 GPS Message: GGA
Survey Lines: 1 GPS ¥ Offset: 0
Comments: 1] GPS v Offset 5
Al zenzors readings: 25644 Survey Mode: Auta
Fiducial Markers: 0 ExtSensor Tepe:  Mone
Sensors Separation [m] 1 GPS Elevation:  Avwailable

Figure 4.2:  Convert Data Files menu after NAV601 file is
loaded to the program

Selected examples of file formats created by TrackMaker601 are given in Appendix B of this
manual.

4.1 Convert NAV601 Data to ASCII Format

The Convert NAV601 Data to ASCII Format option allows you to convert NAV601
binary files to ASCII format, which can be viewed with any text editor and then easily
converted to the other format. Select Convert| NAV601 to ASCII Format from the main
program menu, as shown in Figure 4.2.

After the selected menu item is clicked the Convert NAV601 Files to ASCII Format
window will be displayed in the centre of the screen, Figure 4.3.
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Convert NAVG01 Data to ASC

Il Format

Output File ! I
Format of GRS Ftion:

UTM (G584 ——
 meters

7 feet

U5 Survey fest

|

Original MMEA Meszage
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Format of External Sensor - Mot Available

Convert

Wiew File

e
| o |

Cancel

" Interpreted Data

(% Original Farmat

Exit

Geodetic————————
’7(" DDD M. MMbAM ’7
I

Figure 4.3:  Convert NAV601 Files to ASCII Format dialog

Parameters in Convert NAV601 Data to ASCII Format Window

Several parameters which affect the contents and format of the created output (ASC)
file must be specified. These are the ASCII file name, and Format of GPS Positions (co-
ordinates format or original NMEA statement). The External Sensor option is not used

in this version of the program.

Output File
Click on the Output File button. The Select Output File window is displayed
(Figure 4.4).
Select ASC Output File
1T « Data > TmB01 » Mproject v 0 £ Search Mpraject
Organize New folder Bz - (2]
A Neme - Fype siz
s Quick access .
1) 210504 003.asc ASCFile
OneDrive 1] 210506 001 asc ASCFile
B This pC 7 site_m01.asc. ASC File
30 Ofjects
[ Desktop.
Documents
J Downloads
B Music
=] Pictures
[ RUNR. o< h >
File name: ‘zmsouani v‘
Save astype | ASCH Files (*ASC) ~|
~ Hide Folders e\

Figure 4.4:  Select ASC Output File dialog

Select a file name and click the Save button. The Select ASC Output File win-
dow will close and the selected file name will be displayed beside the Output
File (ASC) button in the Convert NAV601 Files to ASCII Format window.
When Output file is specified the Convert button in the Convert NAV601 Data
to ASCII Format window becomes active.
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Format of GPS Positions

Positions can be written in the output file as geodetic (geographical) coordinates
(Latitude/Longitude), they can be converted to UTM coordinates, or written to
file as original NMEA messages (exactly as streamed by a GPS receiver). The
program uses the WGS1984 datum. To select coordinates click the appropriate
radio buttons in the sections labeled Geodetic or UTM (Figure 4.5).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can
be written in two formats DD.DDDDDDDD or DDMM.MMMMM (native
format found in NMEA GPS messages). To select which format click the appro-
priate radio button in the section labeled Geodetic (Figure 4.3).

UTM coordinates can be generated in meters, feet or US Survey feet. To select
units for UTM coordinates click one of the radio buttons located in the Units
section located at the UTM radio button (Figure 4.5).

Converting NAV601 Data to ASCII Format

When all parameter are set and output file name is specified, the Convert button is
activated in the Convert NAV601 Data to ASCII Format window. After you click the
Convert button, the program begins to read the data, converts data to ASCII format and
writes results to the output file. A progress bar at the bottom of the screen shows the
percentage read (Figure 4.5).

Convert NAVED1 Data to ASCI Format b4
Output File | IE: WDatah T imB01 Y projecth 210513 wWestPart. asc

Format of GPS Positions

Geodetic———— ~ UTM [WGESE4) Original MMEA Message *

" DOD.DDDDDDDD © meters 0 MWMES iew Fil

€ DDDMMMMMMM O fest r iz Fil |
et

© US Survey
Cancel |
Format of External Sensor - Mot Available
’7 [ Include Ext. Sensor " Interpreted Data % Original Farmat ‘ Exit |

Figure 4.5:  Convert NAV601 Files to ASCII Format window during
data processing

The speed of this operation depends on the size of the input file. After the output file
is created the View Converted File button becomes active. Clicking on this button will
display first 63 Kbytes of the created file.
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The created file contains Grad601 readings, GPS positions, and entire information re-
lated to the instrument and survey settings. Example of the output file in ASCII format
is given in Appendix B.

Clicking Cancel button will clear text box at Output File button. Click on Exit button to
close the Convert NAV601 Data to ASCII Format window.

4.2 Retrieve and Position Field Comments

The Retrieve and Position Field Comments option allows you to convert retrieve field
comments from NAV601 binary files. At the same time the program assigns GPS posi-
tions to indicate where these comments were entered by the operator. The position can
be assigned either as a GPS position preceding or position following the comment entry.
The resulting output file consists of coordinates and corresponding text of the comment.
Select Convert | Retrieve and Position Field Comments from the main program menu, as
shown in Figure 4.2.

After the selected menu item is clicked the Position Comments Recorded in NAV601
File window will be displayed in the centre of the screen, Figure 4.6.

Position Comments in NAVED1 Data File >

Coordinates Format [w/E584) Comment Pogition at

Geodetic UTM
* DOD.DODDDDDDD  meters & Last GPS Pasition
 fest
" DDDMM MMMMMMM U5 Survey fest " Nest GPS Pasition
I
Cancel | Exit “Wiew File Eroceed

Figure 4.6: Position Comments in NAV601 Data window

Parameters in Position Comments Recorded in NAV601 File Window

Several parameters which affect the contents and format of the created output (TXT)
file must be specified. These are the output file names, coordinates format, and indicat-
ing type of position of the comment - using a preceding or following GPS reading.
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Output File (TXT)

Click on the Output File (TXT) button. The Select Output File dialog is dis-
played (Figure 4.7).

Select Output File x

4 ||« Data > Tm601 » Mproject v o 2 Search Mproject

Organize » New folder =~ @

A Name Date modified Trpe Siz

OneDrive
5] Msite77_ENC.txt 2021
[E] Msite7s ENC.txt

E This PC 24PM Text Document

J 3D Objects
[ Desktop

| Documents
4 Downloads
b Music

&= Pictures

B Videos

., Windows (C:)

30 PM Text Document

v < >

File name: | West_Comments| v

Save as type: | XY Comment Files (% TXT) -

A Hide Folders Cancel
Figure 4.7: Select Output File dialog

Select a file name and click the Save button. The Select Output File window will
close and the selected file name will be displayed beside the Output File (TXT)
button in the Position Comments Recorded in NAV601 File window.

When both, Input and Output files are specified the Proceed button in the Posi-
tion Comments Recorded in NAV601 File window becomes active.

Coordinates Format

Positions can be written in the output file as geodetic (geographical) coordi-
nates (Latitude/Longitude) or they can be converted to UTM coordinates. The
program uses the WGS1984 datum. To select coordinates click the appropriate
radio buttons in sections labeled Geodetic or UTM (Figure 4.6).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can
be written in two formats DD.DDDDDDDD or DDMM.MMMMM (native
format found in NMEA GPS messages). To select which format click the appro-
priate radio button in section labeled Geodetic (Figure 4.6).

UTM coordinates can be generated in meters, feet or US Survey feet. To select
units for UTM coordinates click one of the radio buttons located in the Units
section located at the UTM radio button (Figure 4.6).
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Comment Position at

This section specifies how GPS positions are assigned to the comment. There
are two choices: Comment can be assigned to the last position that was recorded
by the NAV601 program, or to the position that follows comment entry. In most
cases any choice is right since comments are usually taken while collecting data
(including GPS positions) and during comment entry operator stops record-

ing for a moment. However the option Last GPS Position appears to be more
natural since after the comment entry the operator may stop taking readings
and later continue survey from other location.

To select comment position option click one of the radio buttons labeled Last

GPS Position and Next GPS Position located in the Comment Position at sec-
tion of the window (Figure 4.6).

Positioning Comments Recorded in NAV601 File

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Position Comments Recorded in NAV601 File window. After
you click the Proceed button, the program begins to read the input file, converts data to
ASCII format and writes results to the output file. A progress bar at the bottom of the
screen shows the percentage read (Figure 4.8).

Position Comments in NAVED1 Data File *
Dutput File [TXT) | IC: D atahT rmB01 M projectywest_Comments. ket

Coordinates Format [wWE584) Comment Pozition at
Geodetic UTH
" DOD.DODODDDDD g meters & Last GPS Position
feet
" DDDMM. MM bb I LS Survey feet " Newt GPS Position

0 Commerts Found Cancel | Exit iew File |

Figure 4.8: Position Comments Recorded in NAV601 File during
data processing

The speed of the operation depends on the size of the input file. After the output file is
created the View File button becomes active. Clicking on this button will display first 63
Kbytes of the created file.
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The created file contains GPS positions in the first two columns followed by the text of
comment as recorded in the field. Example of the output file containing comments is
given in Appendix B.

Clicking Cancel button will clear text boxes at Input File (601) and Output File (TXT)
buttons. Click on Exit button to close the Position Comments Recorded in NAV601 File
window.

4.3 Convert GXY Files to XY (ASCII) Format

Files GXY are created by the NAV601 when only GPS data are collected (Grad601 is
Disabled). This type of file contains GPS positions and optionally field comments. The
Convert GXY File to XY (ASCII) Format option allows you to convert GXY binary
file to simple XY type of file. This file contains coordinates placed in first two columns
with optional field comments, elevation, UTC time, local time, and GPS station number
located in following columns. All parameters are always placed in above order. This for-
mat can be viewed with any text editor and it can be easily converted to other formats.

It should be noted that GXY files created with any other Geomar data acquisition pro-
grams (i.e. ML61MK2, NAV61MK2, RTmap38, NAV38, etc.) can be converted to ASCII
format using this option of TrackMaker601.

Select Convert| GXY Files to XY (ASCII) Format from the main program menu, as
shown in Figure 4.1. After the selected menu item is clicked the Convert GXY File to
XY Format window will be displayed in the centre of the screen, Figure 4.9.

Parameters in Convert GXY to XY Format Window

Several parameters which affect the contents and format of the created output (DAT)
file must be specified. These are the input and output names, Coordinates Format, and
contents of the output file.

Input File (GXY)

Click on Input File (GXY) button. The Select GXY Input File window is dis-

played (Figure 4.10).

The window lists files with extension name GXY. Select a file name and click
the Open button. The Select GXY File window will close and the selected file
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[”] Convert GXY or Data File to XY Format

Output File ([DAT)

— Coordinates Format [D atum WGS 1984) [~ Filz Content

Geodstic UTH IT Mumber of Spaces in
" DOD.ODDDDDDDD ¢ meters Frant of Each Record
™ feat

' DODMM. MMM W Include Field Comments
7 US Survey feet
[T Include Elevation Data
— Elewation W Include UTC [GPS] Time
Elevation Units GPS Anterna Height and Unrits [T Include Local Time
r

Include GPS Stn Mumber

Imeters ;I ID.DD Imeters ;I

v Average Positions at GPS stations [if applicable)
I

G=Y, ATmap, and all M&Y data files, as well az MLET, MLETMEZ, and ML31 data can be processed

Cancel | Exit | “iew File | Eroceed
Figure 4.9: Convert GXY Files to XY Format window

[ Select GX¥ or NAV6DT Input File

4 [« Data > Trm601 > Mpraject v | ® | O SesrchMproject
Organize v New folder - M @
A Name Date modified Type -
# Quick access = -
[E| 210523_000.601 2021-05-23 %:51 PM 601 File
OneDiive [l 210602_000.601 2021-06-02 1:17PM 601 File
| 210502001601 2021-06-02 11:19PM 601 Fil
I This PC Q - ’ e
ey anon [E| 210603_000.601 2021- 601 File
@ jects [l 210603 001.501 2021 501 File
[ Desktop [ 210603_002.601 2021- 601 File
Documents [E| 210603 _003.601 2001- 601 File
& Downlosds [E| 210603 _004.601 2021 601 File
B Music [E| 210624 _000.6Xv 2021- GXY File
= victures [E| 210624 001.6xv 2021-06-24 9:58 A GXY File
B videos 210624 002.6XV 2021-06-24 10:08 AM G File
= [l siteM 0606.501 2001-06-24 9:30 AM 01Fle
i Windows (C5) o 5
File name: |z1om47mz.sm - ‘ GXY or NAVEO1 Files (*.GXY,"6( v
Operly |+ Cancel

Figure 4.10: Select GXY Input File window

name will be displayed beside the Input File (GXY) button in the Convert GXY
File to XY Format window.

Output File (DAT)

Click on the Output File (DAT) button. The Select Output File window is dis-
played (Figure 4.11).
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[0 Select Output File X
p

4 ||« Data > Tm601 > Mproject v~ 0 O Search Mproject
Organize ¥ New folder Bz ~ (7]
OneDrive A Name Date madified Tpe Siz
B Thie pC | Msite_South.dat DAT File
= This P
. || Msite_W.dat DAT File
M 3D Objects
[ Desktop
| Documents
4 Downloads
D Music
&=| Pictures
B Videos
i, Windows (C) |, 5
File name; | Msite_East -
Save as type: | XY Files (*.DAT) -
 Hide Foldes Concel

Figure 4.11: Select Output File dialog

Select a file name and click the Save button. The Select Output File window will
close and the selected file name will be displayed beside the Output File (DAT)
button in the Convert GXY File to XY Format window.

When both, Input and Output files are specified the Proceed button in the Con-
vert GXY File to XY Format window becomes active.

Coordinates Format

Positions can be written in the output file as geodetic (geographical) coordinates
(Latitude/Longitude) or they can be converted to UTM coordinates. The pro-
gram uses the WGS1984 datum. To select coordinates click appropriate radio
buttons in sections labeled Geodetic or UTM (Figure 4.9).

Geodetic coordinates, Latitude and Longitude are given in degrees. They can
be written in two formats DD.DDDDDDDD or DDMM.MMMMM (native
format found in NMEA GPS messages). To select which format click the appro-
priate radio button in section labeled Geodetic (Figure 4.9).

UTM coordinates can be generated in meters, feet or US Survey feet. To select
units for UTM coordinates click one of the radio buttons located in the Units
section located at the UTM radio button (Figure 4.9).
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File Contents

This section affects the output file format and contents. It contains one text box
labeled Number of Spaces in Front of Each Record and five check boxes labeled
Include Field Comments, Include Elevation Data, Include UTC (GPS) Time,
Include Local Time, and Include GPS Stn Number.

Number entered in the text box will specify number of spaces in front of each
record. This option may be useful while using created files as control files in
mapping software. To ignore this option enter zero.

Checking box labeled Include Field Comments will cause the program to write
text of all field comment (entered by the operator during the survey) in to the
created file.

The Include Elevation Data option allows you to place elevation values in the
created file. When this option is checked then a set of options in the frame
labeled Elevation is enabled.

When Include GPS Time box is checked the program will write a column con-
taining time of GPS position, and if the Include Local Time box is checked local
(field computer) time will be written to the file.

When the Include GPS Stn (station) Number is checked then sequential GPS
station will be placed in the file. If averaging was used during GPS data collec-
tion (and check box Average Positions... is not checked) then several recorded
GPS positions may have same station number.

Elevation

If Elevation check box is checked then window controls associated with Eleva-
tion are enabled. Please select units for elevation values (these can be meters,
feet, or US Survey feet). To obtain ground elevation values please specify GPS
antenna height and units that were used to measure height of the antenna.

Average Positions at GPS stations

This option can be used only if the similar option is provided in NAV601.

If averaging was used during GPS data collection and the check box labeled
Average Positions at GPS stations is checked then the program will calculate av-
eraged position from all readings taken at each station and one resulting value
will be written to the file. When the check box is not checked then all recorded
positions will be placed in the file.
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Converting GXY File to XY (ASCII) Format

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Convert GXY to XY Format window. After you click the
Proceed button, the program begins to read the input file, converts data to ASCII format
and writes results to the output file. A progress bar at the bottom of the screen shows the
percentage read (Figure 4.12).

DD Convert GXY or Data File to XY Format

Irput File (G IC: WD atahT rmB01 sk project210824_002. Gey'

Dutput File [DAT) IEZ: D atahTrmE01 4M projectiMsite_E ast.dat

— Coordinates Format [0 atum *WGS 1984)——————————  ~File Content
Geodetic UTH IT MNumber of Spaces in
" pDD.ODDDDDDDD & meters Front of Each Recard
" DDDMM. MMMt o M Include Field Comments
= US Survey feet
[T Include Elevation Data
— Elevation W Include UTC (GPS) Time
Elewation Units GPS Antenna Height and Units ™ Include Local Time
[meters ~| oo [meters -] ™ Include GPS Stn Number
¥ Average Positions at GPS stations [if applicable)
315 Positions Cancel Exit iew File

Figure 4.12: Convert GXY Data Files to XY Format window
during data processing

The speed of this operation depends on the size of the input file. After the output file is
created the View File button becomes active. Clicking on this button will display first 63
Kbytes of the created file.

The created file contains GPS positions as recorded in the field. Example of the output
file in ASCII format is given in Appendix B.

Clicking Cancel button will clear text boxes at Input File (GXY) and Output File (DAT)
buttons. Click on Exit button to close the Convert GXY Files to XY Format window.
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4.4 Correct Time Constant Delay in XYZ File

This option allows for the system time constant delay correction. The procedure acts on
two dimensional, GPS positioned data.

While the Grad601 time constant is known (approximately 0.5 s) the time constant of
the combined Grad601 and GPS receiver system is a function of these two devices. The
easiest method to determine the time constant of the system is to survey a known buried
pipe. After the proper time constant delay correction is applied the linear anomaly as-
sociated with the pipe should be free of any “hearing bone” effect. Another method to
determine the time delay is to survey a few lines (in two directions) with varying speeds
over the same small metallic target. When displaying the image the anomaly associated
with the sample target may be slightly displaced or extended in size on neighboring lines.
After the correct time constant for the system is determined the anomaly should be at
the same location for each survey line.

Since the image of two dimensional data can be displayed in a mapping system (after
griding) the procedure can be time consuming, however it only needs to be done once
for a given GPS receiver and Grad601. In order to apply the correction the generated
XYZ file must have time stamps. In the event input file does not have time stamp at
each reading the program will display a warning message.

The correction acts on any XYZ type of file so care should be taken that data is not cor-
rected twice.

To access this option select Convert | Correct Time Constant Delay in XYZ File in the
menu (Figure 4.1). The Correct Time Constant Delay window will appear on the screen
(Figure 4.13).

[I] TrackMakers01 Correct Syster Time Constant Delay in XVZ File

Input File I

Output File

& LUTH [meters or feet)

Systemn Time Constant I 0.4  szeconds LISk D
i Geodetic [LATALOM)

taximum Gap between Readings I 10 seconds

Select Input and Output Files Ermread Bl

Figure 4.13: Correct Time Constant Delay in XYZ File window
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Parameters in Correct Time Constant Delay Window

Several parameters which affect the contents of the created output (XYZ) file must
be specified. These are the Input and Output XYZ file names, System Time Constant,
Maximum Gap between Readings, and type of coordinates in the input XYZ file.

Input File

Click on Input File button. The Select Input XYZ File dialog is displayed (Fig-

ure 4.14).

€ v

Organize »

3 Quick access
OneDrive

[ This PC
1 3D Objects
[ Desktop
%] Documents
4 Downloads

D Music

=] Pictures

<« Trm601 » Mproject v o

Mew folder

0 Name

7 067234a.xy2

7 067234a_GPSaxyz

) 210504_003.as¢

] 210506_001.asc

) 210507 _East.asc

7 210513 WestPart.asc
1 210521_006_meters.xyz

] 210521_006_meters_3_Dxyz
") 210521 006_meters 3 0 GRSxyz

v o<

Select Input XYZ File X

O Search Mproject

=~ M @

Date modified

20, 7 AM
2021-06-15 11:39 PN
20, 42PN

File name: ‘210521_005_mater5‘xyz

~ | XYZ Files (*.XYZ, *.DAT, "ASC) ~

Cancel

A

Figure 4.14: Select Input XYZ File dialog

The window lists files with extension names XYZ, DAT, and ASC. Select a file
name and click the Open button. The Select Input XYZ File window will close
and the selected file name will appear next to the Input File button in the Cor-
rect Time Constant Delay window.

Output File

Click on the Output File button. The Select XYZ File window is displayed

(Figure 4.15).

As a default the Input File name with prefix C is given. Accept the default, en-

ter, or select a file name and click the Save button. The Select Output XYZ File
window will close and the selected file name will be displayed beside the Output
File button in the Correct Time Constant Delay window.

When Input and Output files are specified the Proceed button in the Correct
Time Constant Delay window becomes active (Figure 4.16).
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[1] Select Qutput X¥Z File b

&« v 4 |« TmB01 > Mproject v @ £ Search Mproject

Organize *  New folder =~ @
WD Objects A Name Date modified T
I Desktop 7 06723400y XV
[&] Documents ) 067234a_GPS.xyz XY
4 Downloads ) 210504_003 asc ASe
b Music ) 210506_001 asc ASt

) 210507_East.asc
7] 210513 WestPart.asc
) 210521_006_meters.xyz

=] Pictures

B videos

e Windows (C:)

SN AAEV ARE caees Y A

anv1 Az 1 na -
v o< >

File name: | C210521_006_meters.xyz o

Save as type: | XYZ Files (*.XYZ, *.DAT, ".A5C) ~

~ Hide Folders Cancel
Figure 4.15: Select Output XYZ File dialog

System Time Constant

Time delay 0.4 seconds is given as a default. This value can be changed (0 to 2
seconds), however the user should experiment before choosing a final value.

Maximum Gap Between Readings

This parameter specifies the maximum time during which the Grad601 data will
be treated as continuous data set. If the gap between two stations is larger than
specified maximum gap the station that follows the gap will be assumed the first
station of a new line.

Enter this parameter (in seconds) in the edit box labeled Maximum Gap be-
tween Readings. In most cases a value 2 to 3 times larger than the GPS acquisi-
tion frequency is adequate.

Coordinates in XYZ File

Specity type of coordinates in the input file. The output file will be written with
the same type of coordinates.

Creating XYZ File With Time Delay Corrections

When all parameter are set and input and output file names are specified, the Proceed
button is activated in the Correct Time Constant Delay window. After you click the
Proceed button, the program begins to read and analyze the input file. A label Analyzing

4. Convert Data Files 55



File is displayed at the bottom of the window. The program then calculates corrections
for each station based on the instant velocity of the system at each station. A progress
bar at the bottom of the screen shows the percentage read (Figure 4.16).

[I[] TrackMaker601 Correct System Time Constant Delay in XYZ File

Irpt File | IE:\Data\TrmEEﬂ\Mpmiect\21DE2'I_EIDE_meters.x_l,lz
Dutput File | IE:\Data\TrmBEﬁ ‘Wproject\C210521_00E_METERS »v2

System Time Constant I 045 seconds "Enordmates [ Gl

& |UTH [meters or feet)

td arimum Gap between Readings I 10 seconds " Geodetic [LATALOM)

Calculates comections. .. Exit

I
Figure 4.16: Correct Time Constant Delay in the XYZ File
window during data processing

If the input file does not contain time stamp information, the program will display a
warning message, and it will pause operation till the OK button is clicked in the warning
window.
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NAV601 Data File Format

A.1 Description of NAV601 Data File Format (601) - Windows 10 Format

Each file record contains 27 characters including line feed at the end of each record.

Header of the file contains 3 records starting with characters N, H, and G.

12 3 45 6 7 8 9 10 1112 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27
NAYV 601 AW T 0 0 |SurveyType |UT IM IS {SM] SP svid |10
H Data File Name Separation (F5.2) TG svid |10
G| GPSXOffset F7.2) | GPSY Offset (F7.2) cllru| st|cGplGs svid |10
NAV601 - identification of program file
W100 - version number V1.00
Survey Type - GPS (if GPS Input Enabled) or GRD (grid)
UT - unit type (0 = meters, 1 = feet)
M - notused (=0, fixed)
IS - number of sensors (0 = 1 sensor, 1 = 2 sensors)
SM - not used (= 0, fixed)
IS - Grado601 State (0 = disabled/GXY File, 1 = enabled)
File Name - file name, maximum 8 characters
Separation - Sensors Separation [m], applicable for 2 sensors only
TG - File tag (space= original, 1= Saved As or/and edited)
GPS X Offset -  Offset of GPS antenna in X direction
GPS Y Offset -  Offset of GPS antenna in Y direction
CI - program type (=7, fixed for Windows 10/7)
RU - RTS units (0 = metres or feet, 1 = US Survey Feet)
SL - RTS SLAM option (=0 not used, =1 enabled)
GP - type of GPS NMEA message
(0 = GGA/GSA, 1= GGA, 2 = POS, 3 = LLK,
4=LLQ, 5=GLL, 6 = GGK, 7 = pseudo-GGA (RTS),
8=pseudo-GLL)
GS - GPS state (0 = disabled, 1 = enabled)
svid - logger/software type id (not used)
10 - Line Feed character
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Header at the start of survey line (contains four records starting with L, B, A, and Z)

23 45 6 7 8 9 10010 12 03 1405106 17 18 19 2021 22 23 24 25 26 1T

]
L | Line Name - 8 characters 10
B Start Station (Format F11.2) 10
A |Dir Station Increment  (Format F11.3) 10
ZIDDMMY Y Y Y HH : MM : S S . h h 10

Line Name - Line Name, maximum 8 characters

Start Station-  Start Station for the Line, format F11.2

Dir - Direction of the Line (E, W, N, or S)

Station Inc. -  Station Increment, format F11.3

Date - Date when Line was created, format DD-MM-YYYY

Time - Time when Line was created, format HH:MM:SS.hh

10 - Line Feed character

Timer Reset

12 3 4 5 6 7 8 9 00101 1213 14105706 17 18 19 20 21 22 23 24 25 2 27

* | Computer Time (Format HH:MM:SS.hh) Time Stamp in ms (10 digits) 10

Indicates reset time of the program timer. This record links timer in millisec-
onds and computer time (local time) in format HH:MM:SS.hh. This record is
written to the file each time after the program switches from the Stand By to

Log mode.

Reading
Each instrument record consists of one line that starts with T .

12 3 4 5 6 7 8 9 1011 12 13 1415 16 17 18 19 20 21 22 23 24 25 2 177

T| D |, Reading 1 , Reading 2 Time Stamp in ms (10 digits) 10
T - indicates the first line of instrument record
1D - indicator, $P (fixed string)
s - comma character
Reading1 - five character field containing Sensor #1 output in n'T/m

Reading2 - five character field containing Sensor #2 output in n'T/m,
if one sensor is used then this field contains spaces

Time Stamp-  time stamp of the reading in milliseconds, this is time elapsed
from the last timer reset. The time in milliseconds can be
linked with the computer local time by using Times in line
started by * (see Timer Reset).

10 - Line Feed character
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Comment

12 3 45 6 7 8 9 1010 12 13 141516 17 1819 20 21 22 23 2425 2 1

C Comment (maximum 15 characters) Time Stamp in ms (10 digits) 10

New Station

12 3 45 6 7 8 9 1011 12 13 4 15 106 17 18 19 20 21 22 3 24 25 26 1

S New Station (Format 11.2) Time Stamp in ms (10 digits) 10

Internal Readings

12 3 45 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 1

{|a Internal Position of an Element (Format 14.3) Time Stamp in ms (10 digits) 10

These records (curly brackets) are used only internally during data collection to speed
up map re-drawing in real time.

Records starting with X

Several informative records, for example X$§STARTED indicates start of Logging mode,
X$PAUSED indicates Pause (activated by Pause key stroke), etc.

GPS Data Message Records

Each GPS record (GGA Message) is broken in to several 25 characters strings and
placed in the NAV601 data file which contains 27 characters records, including one
character indicator and line feed at the end of each record. The GPS sequence starts at
the line which contains the character @ as the first character, then records that contain
a continuation of the same message start with the character #. The GPS sequence ends
with a line starting with the character !. The last line contains sequential number of GPS
recorded position and a logger time stamp for the given GPS reading. A sample of the
GPS message written in NAV601 format is given below.

1 45 6 7 8 91001218 1415106171819 2020 2223 2425 2% 17
@ S |G|P|G|G|A|, |h|[h|lm|Im|s|s|.|s]|s ]|, [d]|d[m|m]|. [m|m]|m]I0
#lmlm|, [s], [d]dld]m]m[ . [m[m[m|[m|[m], Is|,[n],Tqlql,[p]0
#lpl|.|p|,|slalalalalal.|alal,{u|,|E[x|x|x]|x]|.|x]|,[M|10
#|,|s|s|s|.,|alalal|*|c]|c]|CR|LF 10
1loj0|4]3]|5 Time Stamp in ms (10 digits) 10
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The GPS sequence may contain 4 to 7 records. The components of the GGA message
may differ in length, however they are placed in the same number of columns. Refer to
Appendix B (section B.2) for the definition of each component of the GGA data mes-
sage. Other available GPS messages in NMEA format, GSA, POS, LLK, LLQ, GLL,
and GGK, are recorded similarly. The structure of these NMEA sentences is given in
section B.2 of Appendix B.

If the Checksum in NMEA message is invalid then starting character @ is replaced by ?,
and # is replaced by " (ASCII character code 34). The starting character of Time Stamp
record ! remains the same.

In case not selected NMEA messages are streamed by connected GPS receiver then
such not needed positions are tagged by X and only first few elements are recorded in
the file together with time stamp. It is just to trace and document GPS receiver activity.

A.2 Example of NAV601 Data File - Windows 10 Format

NAV601 AW100GPSO 0 111

H210603_002 1.00 0

G 0.000 0.400 70011 O1B
L14.00

B 3870.00

AE 1.000

203062021 21:30:47
*21:30:47.221 1470603109

X$STARTED 1470622781
T$P, 8.3, 6 1470622828
T$P, 8.7, 7 1470622906

@$GPGGA,014058,4337.0207,N
#,07939.0158,W,8,10,2.0,17
#5.5,M,-35.4,M, ,%*70

1000001p 1470622812
{0 0.000

T$P, 8.4, 6 1470623000
X$GPGSA,A,3,05,10,13,15,18
T$P, 8, 7 1470623109
T$P, 8, 7 1470623187
X$GPGSV,3,2,10,18,80,250,5
T$P, 8, 7 1470623281
X$GPGLL, 4337.0202,N,07939.
T$P, 8, 7 1470623359
X$GPBOD,325.5,T,336.2,M,TO
T$P, 8, 7 1470623453
T$P, 8, 6 1470623546
X$GPBWC,014058,3512.7660,N
T$P, 8, 7 1470623625
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X$GPVTG,0.0,T,10.8,M,0.0,N
X$GPXTE,V,V,9.99,L,N,S*18

TSP, 8, 7 1470623734
TSP, 8, 7 1470623812
TSP, 8, 7 1470623906
TSP, 8, 5 1470624000
TSP, 8, 6.6 1470624078
TSP, 8, 7 1470624171
TSP, 8, 7 1470624250
TSP, 8, 7 1470624343
TSP, 8, 6 1470624453
TSP, 8, 7 1470624531
TSP, 8, 7 1470624625
X$GPRMC, 014100,V,4337.0202
TSP, 8, 7 1470624703
TSP, 8, 7 1470624796
X$GPRMB,V,9.99,L, TOUR4 , TOU
TSP, 8, 6 1470624890

@$GPGGA,014100,4337.0213,N
#,07939.0157,W,8,10,2.0,17
#5.5,M,-35.4,M, ,*7C
1000002p 1470624812
{a 608907.054

{b  4830221.450

{c 608909.048

{d  4830221.302

{e 608907.135

{f 4830222 .544

{g  608909.129

{h  4830222.396

TSP, 8, 7 1470624968
TSP, 8, 7 1470625078
X$GPGSA,A,3,05,10,13,15,18
TSP, 8, 7 1470625156
X$GPGSV, 3,3,10,27,16,317,4
TSP, 8, 7 1470625250
X$GPGLL, 4337.0202,N,07939.
TSP, 8, 7 1470625343
X$GPBOD,325.5,T,336.2,M,TO
TSP, 8, 7 1470625421
X$GPBWC,014100,3512.7660,N
TSP, 8, 6 1470625515
X$GPVTG,0.0,T,10.8,M,0.0,N
TSP, 8, 7 1470625593
X$GPXTE,V,V,9.99,L,N,S*18

TSP, 8, 7 1470625687
TSP, 8, 7 1470625796
TSP, 8, 6 1470625875
TSP, 8, 6 1470625968
TSP, 8, 7 1470626046
TSP, 8, 7 1470626140
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A.3 Description of NAV601 Data File Format (601) - Windows Mobile Format

Each file record contains 27 characters including line feed at the end of each record.

Header of the file contains 3 records starting with characters N, H, and G.

102 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 77
NAYV 601 W 1 3 4 |SurveyType [UT| [IM 1S svid {10
H Data File Name Samples G svid |10
G| GPSXOffset (F7.2) GPS Y Offset (F7.2) GR|GP|GS svid |10

NAV601 - identification of program file

W134 - version number V1.34, W is fixed

Survey Type - GPS (if GPS Input Enabled) or GRD (grid)

UT - unit type (0 = meters, 1 = feet)

IM - Grad601 survey mode

(0 = Auto, fixed)

IS - Grad601 type (1 = 1 sensor, 2 = 2 sensors)

File Name - file name, maximum 8 characters

Samples - notused

TG - File tag (space= original, 1= Saved As or/and edited)

GPS X Offset -  Offset of GPS antenna in X direction

GPS Y Offset -  Offset of GPS antenna in Y direction

GR - GPS update rate (0 = not used)

GP - type of GPS NMEA message

(0 = GGA/GSA, 1= GGA, 2 = POS, 3 = LLK,
4=LLQ, 5=GLL, 6 = GGK, 7 = Leica TPS,
8§=Trimble RTS)

GS - GPS state (0 = Disabled, 1 = Enabled)
svid - logger/software type id (not used)
10 - Line Feed character

Header at the start of survey line (contains four records starting with L, B, A, and Z)
273 45 6 7 8 9 1001 1213 141576 17 18 19 20 21 22 23 24 25 26 17

|

L | Line Name - 8 characters 10
B Start Station (Format F11.2) 10
A |Dir Station Increment  (Format F11.3) 10
ZIDDMM Y Y Y Y HH : MM : S S . h h 10
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Line Name - Line Name, maximum 8 characters
Start Station-  Start Station for the Line, format F11.2

Dir - Direction of the Line (E, W, N, or S)

Station Inc. -  Station Increment, format F11.3

Date - Date when Line was created, format DD-MM-YYYY
Time - Time when Line was created, format HH:MM:SS.hh
10 - Line Feed character

Timer Reset

12 3 4 5 6 7 8 9 0011 1213 14105706 17 18 19 20 21 22 23 24 25 26 27

* | Computer Time (Format HH:MM:SS.hh) Time Stamp in ms (10 digits) 10

Reading

Indicates reset time of the program timer. This record links timer in millisec-
onds and computer time (local time) in format HH:MM:SS.hh. This record is
written to the file each time after the program switches from the Stand By to
Log mode. In case when data are taken continousely the timer is automatically
reset every hour.

Each instrument record consists of two lines, the first line starts with T and the
second line starts with > .

12 3 4 5 6 7 8 9 10011 12 13 1415 16 17 18 19 20 21 22 23 24 25 26 77

T Indicator Reading 1 Reading 2 10
> | Readings Counter Time Stamp in ms (10 digits) 10

T - indicates the first line of instrument record

Indicator - $PBAR (fixed string)

Reading1 - four character field containing Sensor #1 output in nT

Reading2 - four character field containing Sensor #2 output in n'T]

if one sensor is used then this field contains spaces
> - indicates the second line of the instrument record
Counter - six digits field containing sequential number of reading

Time Stamp-  time stamp of the reading in milliseconds, this is time elapsed
from the last timer reset. The time in milliseconds can be
linked with the computer local time by using Times in line
started by * (see Timer Reset).

10 - Line Feed character
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Comment

12 3 45 6 7 8 9 1010 12 13 141516 17 18 19 20 21 22 23 24 25 26 1
C Comment (maximum 15 characters) Time Stamp in ms (10 digits) 10
New Station
12 3 4 5 6 7 8 9 1010 1213 14 15 16 17 18 19 20 21 22 23 24 25 26 1]
S New Station (Format 11.2) Time Stamp in ms (10 digits) 10
GPS Data Message Records
Each GPS record (GGA Message) is broken in to several 22 characters strings and
placed in the NAV601 data file which contains 24 characters records, including one
character indicator and line feed at the end of each record. The GPS sequence starts at
the line which contains the character @ as the first character, then records that contain
a continuation of the same message start with the character #. The GPS sequence ends
with a line starting with the character !. The last line contains sequential number of GPS
recorded position and a logger time stamp for the given GPS reading. A sample of the
GPS message written in NAV601 format is given below.
12 3 4 5 6 7 8 9 10101213 1415176 171819 20 21 22 283 24 25 26 17
@|$S|G|P|G|G|A|, |h|lh|m|m|s|s]|.|s]|s |, |[d|d|m|m]|. |[m]|m|[m |10
#lmm|, |s|, |[dld|d|{m|{m|[.|m|m[m|{m|[m|,|[s|,|n]|,|q|lqg|,|p]|l0
#|p pl,|slalalalalal.lalal,[ul,|+£|x]|x|x|[x|.|x]|,|M][I0
#|,1s|s|s|,|alalal|l*|c|c|CRILF 10
F[O|0|4|3]5 Time Stamp in ms (10 digits) 10

The GPS sequence may contain 4 to 7 records. The components of the GGA message
may differ in length, however they are placed in the same number of columns. Refer to
Appendix B (section B.2) for the definition of each component of the GGA data mes-
sage. Other available GPS messages in NMEA format, GSA, POS, LLK, LLQ, GLL,
and GGK, are recorded similarly. The structure of these NMEA sentences is given in
section B.2 of Appendix B.

If the Checksum in NMEA message is invalid then starting character @ is replaced by ?,
and # is replaced by " (ASCII character code 34). The starting character of Time Stamp
record ! remains the same.
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A.4 Example of NAV601 Data File - Windows Mobile Format

The NAV601 data file records are written in binary format, therefore characters may

have a different shape when displayed or printed, depending on particular video or

printer settings.

NAV601 W130GPSO 0 2
H 052012A 0.200

G 0.00 0.00
Lo
B 0.00

AS 1.000
220052008 12:47:53

*12:47:53.000
X$STARTED

T$PBAR, 1130,2504
>000001

T$PBAR, 1320,2607
>000002
T$PBAR,1430,2603
>000003
T$PBAR, 1550 ,2307
>000004
T$PBAR, 1650 ,2457
>000005

T$PBAR, 1733,2507
>000006

T$PBAR, 1840,2767
>000007

02
2C

001 FE

147944
149140

149186

149296

149406

149516

149626

149736

149845

@$GPGGA,182702.00,4336.593
#81,N,07936.64493,W,2,7,2,
#141.84,M,-35,M,4,118*5D

'000001p

149880

@$GPGSA,A,3,32,,,22,,18,14
#,12,,09,05,,02.5,01.5,01.

#9%0B

1000001
T$PBAR,1920,2534
>000008

T$PBAR, 1330,2307
>000009
T$PBAR,1300,2534
>000010
T$PBAR,1200,2207
>000011
T$PBAR,1200,3407
>000012
T$PBAR,1100,2507
>000013

T$PBAR, 1300,3607
>000014

149915

149955

150065

150175

150285

150395

150505

150615
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A.5 Format of GXY Data File

The NAV601 data file with extension GXY contains GPS records. The structure of this
file is identical to the standard NAV601 (601) file. The difference is that it does not con-
tain any Grad601 records. This file is created by NAV601 when Grad601 is Disabled in
the System Setup menu. In this case the program acts as a GPS logging program.

It should be noted that any NAV601 data file, as well as GXY and data files created by
other Geomar data acquisition programs (NAV38, NAV61, ML61, ML31, etc.) can be
used as an GXY file in the data processing programs TrackMaker601 and TrackMaker
for any other supported Geonics instrument (TrackMaker38, 61, etc.). The extension
name GXY indicates that the file does not contain magnetic data.
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File Formats

B.1 Description of NAV601 File in ASCII Format

The NAV601 data file converted to ASCII format contains information related to the
instrument output and GPS positions. The format of the file is self explanatory.

The file starts with a header block, which starts with the line NAV601 File Header and
it ends with line End of file header. The file header includes: NAV601 version number,
type of positioning, distance units, number of sensors, survey mode, name of data file
(as entered during the survey), GPS Antenna location, GPS NMEA message type, and
offsets for GPS antenna.

The file contains at least one survey line (even if survey lines are not used with GPS
positioning). Each survey line starts with a Line Header Block. The Line Header Block
contains four lines describing: survey line name, start station, station increment, date
(MM/DD/YYYY) and time (HH:MM:SS) of line creation.

Reading starts by station number, and it is followed by instrument readings. Instrument
reading is represented by two values (one for each sensor). Time stamp (format HH:
MM:SS.ttt) is placed in the last column.

Line that starts with C corresponds to field comment, and line that starts with N indi-
cates entry of New Station.

GPS data consists of one or two lines starting with GP and GQ. Line containing GP is
always present and it contains position, while line starting with GQ corresponds to qual-
ity of GPS reading.

Line that starts with GP contains position, UTC time, and local time. If Geodetic Coor-
dinates were selected the position is indicated by Latitude and Longitude. In case when
UTM coordinates were selected the position is described by UTM Zone number, East-
ing and Northing (see example of the file below). The second line that starts with GQ
describes quality of GPS position and it contents depends on the NMEA message used
during the survey. In the example of the file GQ statement is given for NMEA message
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pair GGA/GSA and contains: Position Quality, statu:

s of differential corrections, and

index PDOP. For other NMEA messages contents of line starting with GQ may differ.

Line containing GPS position may also include original NMEA message if this option
was selected in Convert NAV601 File to ASCII Format window.

Two Examples of NAV601 Files in ASCII Format

1. Geodetic coordinates

NAV601 File Header Version W1.30
Positioning: GPS Distance units: meters
Sensor Type: Grad601-2 (2 Sensors) Survey Mode: Auto
External Sensor: None
Data File : 052012A.601
GPS Message : GGA/GSA
GPS Antenna Position
GPS X offset: 0.00
GPS Y offset: 0.00
End of file header

Survey Line 0
Start Station : 0.00
Station Increment: 1.000
Date: 20/05/2008 Time: 12:47:53
.000 1130. 2504.
000 1320. 2607.
.000 1430. 2603.
.000 1550. 2307.
.000 1650. 2457.
.000 1733. 2507. 154.791
.000 1840. 2767. :54.900
GP 79.6107488,W, 43.6098968,N, 18:27:02.00
GQ Position: 3D Differential (DGPS) PDOP: 02.5
7.000 1920. 2534, .010
8.000 1330. 2307. .120
9.000 1300. 2534, .230
.000 1200. 2207. .341
11.000 1200. 3407. .450
.000 1100. 2507. .560
.000 1300. 3607. .670
.000 1400. 2007. .780
.000 1500. 2207. :55.890
GP 79.6107480,W, 43.6099028,N, 18:27:03.00
GQ Position: 3D Differential (DGPS) PDOP: 02.5
.000 1600. 1907. .000
.000 1700. 1007. .110
.000 1800. 1507. .220
.000 1900. 1577. .330
.000 1300. 2407. .440
.000 1400. 2507. .550
.000 1600. 2207. .659
.000 1150. 407. .769

154,
154,
154,
154,
154,

241
351
461
572
681

OO AWN—=O

12:47:54.935
12:47:54.935

12:47:55.935
12:47:55.935
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24.000 1130.00 507.00 12:47:56.879

GP 79.6107467,W, 43.6099097,N, 18:27:04.00 12:47:56.935
25.000 1320.00 607.00 12:47:57.007
GQ Position: 3D Differential (DGPS) PDOP: 02.5 12:47:57.007

26.000 1430.00 607.00 12:47:57.099

27.000 1550.00 307.00 12:47:57.209

28.000 1650.00 407.00 12:47:57.319

29.000 1733.00 507.00 12:47:57.430

30.000 1840.00 707.00 12:47:57.539

31.000 1920.00 577.00 12:47:57.649

32.000 1300.00 307.00 12:47:57.754

33.000 1500.00 507.00 12:47:57.864
GP 79.6107460,W, 43.6099138,N, 18:27:05.00 12:47:57.934
GQ Position: 3D Differential (DGPS) PDOP: 02.5 12:47:57.934

34.000 1500.00 1207.00 12:47:57.973

35.000 1700.00 3407.00 12:47:58.083

36.000 1570.00 2507.00 12:47:58.193

37.000 1540.00 3607.00 12:47:58.303

38.000 1750.00 2007.00 12:47:58.414

39.000 1500.00 2207.00 12:47:58.523

40.000 1665.00 1907.00 12:47:58.633

41.000 1745.00 1007.00 12:47:58.743

42.000 1480.00 1507.00 12:47:58.853

GP 79.6107440,W, 43.6099212,N, 18:27:06.00 12:47:58.933
43.000 1600.00 1577.00 12:47:58.972
GQ Position: 3D Differential (DGPS) PDOP: 02.5 12:47:58.972

44.000 1440.00 2407.00 12:47:59.073
45.000 1400.00 2507.00 12:47:59.183
46.000 1600.00 2207.00 12:47:59.293
47.000 1150.00 2203.00 12:47:59.403
48.000 1130.00 2504.00 12:47:59.513
49.000 1320.00 2607.00 12:47:59.623
50.000 1430.00 2603.00 12:47:59.733
51.000 1550.00 2307.00 12:47:59.843

2. Original NMEA messages

NAV601 File Header Version W1.30
Positioning: GPS Distance units: meters
Sensor Type: Grad601-2 (2 Sensors) Survey Mode: Auto
External Sensor: None
Data File : 052012A.601
GPS Message : GGA/GSA
GPS Antenna Position
GPS X offset: 0.00
GPS Y offset: 0.00
End of file header

Survey Line 0

Start Station : 0.00

Station Increment: 1.000

Date: 20/05/2008 Time: 12:47:53
0.000 1130.00 2504.00 12:47:54.241
1.000 1320.00 2607.00 12:47:54.351
2.000 1430.00 2603.00 12:47:54.461
3.000 1550.00 2307.00 12:47:54.572
4.000 1650.00 2457.00 12:47:54.681
5.000 1733.00 2507.00 12:47:54.791
6.000 1840.00 2767.00 12:47:54.900
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$GPGGA, 182702.00,4336.59381,N,07936.64493,W,2,7,2,141.84,M,-35,M,4,118*5D
$GPGSA,A,3,32,,,22,,18,14,12,,09,05,,02.5,01.5,01.9*0B

2534.
2307.
2534.
2207.
3407.
2507.
3607.
2007.
2207.

7.000
8.000
9.000
10.000
11.000
12.000
13.000
14.000
15.000

1920.
1330.
1300.
1200.
1200.
1100.
1300.
1400.
1500.

$GPGGA, 182703.00,

16.000
17.000
18.000
19.000
20.000
21.000
22.000
23.000
24.000

1600.
1700.
1800.
1900.
1300.
1400.
1600.
1150.
1130.

$GPGGA, 182704.00,

25.000

26.000
27.000
28.000
29.000
30.000
31.000
32.000
33.000

1320.

1430.
1550.
1650.
1733.
1840.
1920.
1300.
1500.

$GPGGA, 182705.00,
$GPGSA,A, 3,32, ,,22,,18,14,12,,09,05,,02.5

34.000
35.000
36.000
37.000
38.000
39.000
40.000
41.000
42.000

1500.
1700.
1570.
1540.
1750.
1500.
1665.
1745.
1480.

$GPGGA, 182706.00,

43.000

44.000
45.000
46.000
47.000
48.000
49.000
50.000

1600.

1440.
1400.
1600.
1150.
1130.
1320.
1430.

00
00
00
00
00
00
00
00
00

12:

a7:

.010
.120
.230
.341
.450
.560
.670
.780
.890

4336.59417,N,07936.64488
$GPGSA,A, 3,32, ,,22,,18,14,12,,09,05,,02.5

00
00
00
00
00
00
00
00
00

00

00
00
00
00
00
00
00
00

00
00
00
00
00
00
00
00
00

1907.
1007.
1507.
1577.
2407.
2507.
2207.
407.
507. :
4336.59458,N,07936.64480

00
00
00
00
00
00
00
00
00

12:

a7:

56.
.110
.220
.330
.440
.550
.659
.769
.879

000

607.00 12:47:57.007
$GPGSA,A, 3,32, ,,22,,18,14,12,,09,05,,02.5

607.
307.
407.
507.
707.
577.
307.

507

1207.
3407.
2507.
3607.
2007.
2207.
1907.
1007.
1507.

00
00
00
00
00
00
00
00

12:

12:

12:

a7:

. 47:
4336.59483,N,07936.64476

a7:

57.
.209
.319
.430
.539
.649
.754
57.

57.
.083
.193
.303
.414
.523
.633
.743
.853

099

864

973

4336.59527,N,07936.64464
1577.00 12:47:58.972
$GPGSA,A,3,32,,,22,,18,14,12,,09,05,,02.5

00

00
00
00
00
00
00
00

2407.
2507.
2207.
2203.
2504.
2607.
2603.

12:

a7:

.073
.183
.293
.403
.513
.623
.733

12:47:54.935
12:47:54.935

W,2,7,2,141.84,M,-35,M,5,118*5E
,01.5,01.9*0B

12:47:55.935
12:47:55.935

W,2,7,2,141.83,M,-35,M,6,118*51 12:47:56.935

,01.5,01.9*0B 12:47:57.007

12:47:57.934
12:47:57.934

W,2,7,2,141.61,M,-35,M,5,118*50
,01.5,01.9*0B

W,2,7,2,141.64,M,-35,M,6,118*54 12:47:58.933

,01.5,01.9*0B 12:47:58.972
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B.2 NAV601 GXY File in ASCIl Format

The GXY type of file while converted to ASCII format with extension name DAT
consists of coordinates in UTM or Geodetic format. While in UTM format Easting
coordinate is located in the first column and Northing in the second column. If Geodetic
format was selected then Longitude is written in the first column and Latitude in the sec-
ond column. Optionally the file may include GPS UTC time and text of field comments.

Example of GXY File in ASCIl Format (UTM Coordinates)

612102.229 4829484.278 01:59:17.00
612102.255 4829484.352 01:59:18.00
612102.241 4829484.389 01:59:19.00
612102.349 4829484.391 01:59:20.00
612102.268 4829484.408 01:59:21.00
Comment: “Stake #3”
612102.578 4829484.339 01:59:32.00
612102.564 4829484.376 01:59:33.00
612102.578 4829484.339 01:59:34.00
612102.579 4829484.284 01:59:35.00
612102.718 4829484.045 01:59:36.00
Comment: “bldg corner”
612102.730 4829484.101 01:59:53.00
612102.784 4829484.121 01:59:54.00
612102.853 4829483.992 01:59:55.00
612102.813 4829483.973 01:59:56.00

Example of GXY File in ASCIl Format (Geodetic Coordinates)

-79.610841500 43.609900500 01:59:17.00
-79.610841167 43.609901167 01:59:18.00
-79.610841333 43.609901500 01:59:19.00
-79.610840000 43.609901500 01:59:20.00
-79.610841000 43.609901667 01:59:21.00
Comment: “Stake #3”
-79.610837167 43.609901000 01:59:32.00
-79.610837333 43.609901333 01:59:33.00
-79.610837167 43.609901000 01:59:34.00
-79.610837167 43.609900500 01:59:35.00
-79.610835500 43.609898333 01:59:36.00
Comment: “bldg corner”
-79.610835333 43.609898833 01:59:53.00
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B.3 Retrieved and Positioned Field Comments

File containing retreived and positioned comments starts with a header indicating name
of the original NAV601 data file. This is followed by coordinates and text of comment
enclosed in double quotes. Coordinates can be written in UTM or Geodetic format.
Column one includes Easting or Longitude, and second column contains Northing or
Latitude. The optional, fourth column of the file includes local time.

Example of File Containing Positioned Comments (Geodetic Coordinates)

Comments in Data File : 052818A.823
-79.610851833 43.609890333 “Stake#10” 18:17:41.934
-79.610850500 43.609890167 “Stake#20” 18:29:32.187
-79.610833500 43.609879500 “Stake#30” 18:29:36.834
-79.610833500 43.609879500 “Stahe#40” 18:29:41.974
-79.610833500 43.609879500 “WoodPile” 18:29:47.636
-79.610835167 43.609885833 “Sm Tree ” 18:37:11.833

B.4 Output File (XYZ)

The output XYZ file may be written in two output formats: Generic and Geosoft type of
XYZ file. The only difference between these two formats is that Geosoft format contains
line labeled Line # at the beginning of each survey line.

Coordinates can be written in UTM or Geodetic format. Column one includes Easting
or Longitude, and second column contains Northing or Latitude. The optional column
that includes a reading time stamp (local time) is always placed as the last column in the
file.

The XYZ file may also contain field comments. All lines containg description text start
with character “\” with the exception of label Line# if Geosoft data type is used. If the
Include Header Info option was used then each file contains header fully describing
XYZ file contents. See the example of the XYZ file given below. This sample file is in
geodetic coordinates and it contains elevation data.
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Example of XYZ File Created by TrackMaker601

//Sensor #1 followed by Sensor #2

// Geodetic [DDD.DDDDDD], Datum: WGS1984
// Longitude, Latitude,

Line 0_1
-79.610761099
-79.610761009
-79.610760920
-79.610760830
-79.610760728
-79.610760639
-79.610760549
-79.610760459
-79.610760328
-79.610760184
-79.610760031
-79.610759889
-79.610759748
-79.610759595
-79.610759453
-79.610759300
-79.610759159
-79.610759005
-79.610758941
-79.610758861
-79.610758789
-79.610758716
-79.610758644

43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.

609898181
609898838
609899503
609900159
609900815
609901480
609902137
609902802
609903674
609904527
609905282
609906036
609906782
609907536
609908291
609909036
609909782
609910537
609910635
609911390
609911848
609912307
609912765

1920.
1330.
1300.
1200.
1200.
1100.
1300.
1400.
1500.
1600.
1700.
1800.
1900.
1300.
1400.
1600.
1150.
1130.
1320.
1430.
1550.
1650.
1733.

Sensor, Elev.[m],

141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141

and after end of Sensor #1 data

Line 0_2

-79.610748772
-79.610748680
-79.610748589
-79.610748497
-79.610748405
-79.610748314
-79.610748222
-79.610748130
-79.610748039
-79.610747915
-79.610747769
-79.610747622
-79.610747475
-79.610747329
-79.610747182
-79.610747037
-79.610746890
-79.610746743
-79.610746573
-79.610746558
-79.610746484
-79.610746411

43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.
43.

609897274
609897934
609898594
609899254
609899914
609900574
609901234
609901894
609902554
609903267
609904019
609904771

609905522
609906274
609907026
609907770
609908522
609909274
609910148
609910346
609910807
609911267

for Sensor #2

2534.
2307.
2534.
2207.
3407.
2507.
3607.
2007.
2207.
1907.
1007.
1507.
1577.
2407.
2507.
2207.

407.

507.

607.

607.

307.

407.

141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141
141

.840
.840
.840
.840
.840
.840
.840
.840
.840
.839
.838
.837
.836
.835
.834
.833
.832
.831
.829
.794
.770
.746
.721

.840
.840
.840
.840
.840
.840
.840
.840
.840
.839
.838
.837
.836
.835
.834
.833
.832
.831

.829
.794
.770
.746

Quality, Sat., PDOP,

NSEN\CI \CI L\ \CIE\O RN \CTE \O RN \C I\ 2N \C T\ \C T\ B \C T \O B \C T\ B \C T\ B \C T\ I \V ]

follows

NS\ SIE O \CTR \O N \CT \C I \C T \O R \C I O \C I \C I \C I O \O I O \O D \C I \V I |V

NONCNN N N N N N N N N N N N N N N N N N NN

NN NN N N N N N N N N N N N N N NN N NN

[\CRN \O2N \O R \o R \O B \C I \O B \C I \C I \C I \C I \C T \C I \C T \O I \O 0\ B \O B\ I \O B\ B\ I 0

[ASIN 2 CRN \C RN \C R \C R \C I \C I \C I \C I \C T \C I \C I \O T \O B \O B\ 2\ \O B\ I\ I \ 0]

Time

12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:

12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:
12:

12:

47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:

47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
47:
147
47:

.010
.120
.230
. 341
.450
.560
.670
.780
.890
.000
.110
.220
.330
.440
.550
.659
.769
.879
.007
.099
.209
.319
.430

.010
.120
.230
. 341
.450
.560
.670
.780
.890
.000
.110
.220
.330
.440
.550
.659
.769
.879
.007
.099
.209
.319
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Example of XYZ File in Line Format

//WGS84-Zn17:Easting[m] Northing[m] Sensor_Data Elev.[m] Quality Sat. HDOP Time
Line 10 - Sensor#1

] 608907.744 4830221.204 46.00 174.250
608907.743 4830221.256 47.00 174.250
608907.742 4830221.307 46.00 174.250
608907.741 4830221.351 46.00 174.250
608907.740 4830221.403 46.00 174.250
608907.740 4830221.455 46.00 174.250
608907.739 4830221.507 46.00 174.250
608907.738 4830221.559 46.00 174.250
608907.737 4830221.611 46.00 174.250
608907.736 4830221.655 46.00 174.250
608907.735 4830221.707 46.00 174.250
608907.735 4830221.759 46.00 174.250
608907.734 4830221.811 46.00 174.250
608907.733 4830221.863 46.00 174.250
608907.732 4830221.915 46.00 174.250
608907.731 4830221.967 46.00 174.250
608907.730 4830222.010 47.00 174.250
608907.730 4830222.063 47.00 174.250
608907.729 4830222.114 47.00 174.250
608907.728 4830222.158 47.00 174.250
608907.727 4830222.219 47.00 174.250
608907.726 4830222.271 46.00 174.250

and label "e" at the end of survey line

.00 15:51:11.517
.00 15:51:11.611
.00 15:51:11.704
.00 15:51:11.782
.00 15:51:11.876
.00 15:51:11.970
.00 15:51:12.064
.00 15:51:12.157
.00 15:51:12.251
.00 15:51:12.329
.00 15:51:12.423
.00 15:51:12.517
.00 15:51:12.611
.00 15:51:12.704
.00 15:51:12.798
.00 15:51:12.892
.00 15:51:12.970
.00 15:51:13.064
.00 15:51:13.157
.00 15:51:13.236
.00 15:51:13.345
.00 15:51:13.439

O 00 0 00 0O 0O 0 0 00 0O O 0 0 0 O W W 0 W W o
© © © © O O O© O O O O© O© O O OV OO OOV oo
NS\ \CRE \C I (G \C T \C I \C I \C I \C TR \C T \O N \O I \C T \C T \C I \O I \C I \C TN \C T \L N \G )

608917.239 4830236.528 15.00 174.250 8 9 2.00 16:00:51.048
608917.246 4830236.589 24.00 174.250 8 9 2.00 16:00:51.157
608917.250 4830236.633 32.00 174.250 8 9 2.00 16:00:51.236
608917.256 4830236.684 36.00 174.250 8 9 2.00 16:00:51.329

e 608917.261 4830236.737 41.00 174.250 8 9 2.00 16:00:51.423

Line 12.00 - Sensor#1

s 608917.293 4830237.863 36.00 174.250 8 9 2.00 16:01:39.564
608917.292 4830237.914 42.00 174.250 8 9 2.00 16:01:39.657
608917.291 4830237.966 46.00 174.250 8 9 2.00 16:01:39.751
608917.290 4830238.009 49.00 174.250 8 9 2.00 16:01:39.829
608917.289 4830238.061 52.00 174.250 8 9 2.00 16:01:39.923
608917.288 4830238.121 51.00 174.250 8 9 2.00 16:01:40.032
608917.288 4830238.165 41.00 174.250 8 9 2.00 16:01:40.111
608917.287 4830238.216 33.00 174.250 8 9 2.00 16:01:40.204
608917.286 4830238.268 24.00 174.250 8 9 2.00 16:01:40.298
608917.285 4830238.311 16.00 174.250 8 9 2.00 16:01:40.376
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Selected NMEA Messages

GGA Data Message

The GGA message contains the GPS position information and it is the most widely used
NMEA data message. This message takes the following form:

$GPGGA ,hhmmss.ss,ddmm.mmmmm,s,dddmm.mmmmm,s,n,qq,pp.p,saaaaa.aa,u,
+xxxx.x,M,sss,aaaa*cc<CR><LF>

Definition of GGA message component:

hhmmss.ss UTC time in hours, minutes, seconds of the GPS position
ddmm.mmmmm Latitude in degrees, minutes, and decimal minutes

S s=N or s=S, for North and South latitude
dddmm.mmmmm Longitude in degrees, minutes, and decimal minutes

s s=E or s=W, for East and West longitude

n Quality indicator,

0 = no position, 1 = raw, no differentially corrected position,
2 = differentially corrected position, 9 = position computed
using almanac information

qq Number of satellites used in position computation
Pp-p HDOP = 0.0 t0 99.9

saaaaa.aa Antenna altitude

u Altitude units, M=meters

+XXXX.X Geoidal separation (requires geoidal height option)

M Geoidal separation units, M = meters

SSS Age of differential corrections in seconds

aaaa Base station identification

*cc Checksum

<CR><LF> Carriage return and Line feed
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GSA Data Message

The GSA message contains active satellites and PDOP value. The GSA message is given
in the following form:

$GPGSA,c1,d1,d2,d3,d4,d5,d6,d7,d8,d9,d10,d11,d12,d13,f1,£2,f3*cc< CR> <LF>

Definition of GSA message components:

cl Mode, M = manual, A = automatic
d1 Mode, 2 = 2D, 3 = 3D
d2-d13 Satellites used in position computation (range 0 to 32)
f1 PDOP (range 0 to 99.9)
2 HDOP (range 0 to 99.9)
f3 VDOP (range 0 to 99.9)
*cc Checksum
<CR><LF> Carriage return and Line Feed
POS Data Message

The POS message contains the GPS position information and PDOP value. The POS
message is given in the following form:

$PASHR,POS,n,qq,hhmmss:ss,ddmm.mmmmm,s,dddmm.mmmmm,s,saaaaa.aa,seeeee,
ttt,ggg,svvv,pp,hh,vv,tt,vvwv*cc<CR> <LF>

Definition of POS message components:
n Quality indicator,

0 = no differentially corrected position,
1 = differentially corrected position

qq Number of satellites used in position computation
hhmmss:ss UTC time in hours, minutes, seconds of the GPS position
ddmm.mmmmm Latitude in degrees, minutes, and decimal minutes

S s=N or s=S, for North and South latitude
dddmm.mmmmm Longitude in degrees, minutes, and decimal minutes

s s=E or s=W, for East and West longitude

saaaaa.aa sensor computed altitude

seeeee reserved
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ttt

ggg
SVVV

pp

hh

A%

tt

VVVV

*cc
<CR><LF>

LLK Data Message

True track/true course over ground in degree
Speed over ground (knots)

Vertical velocity (decimeters per second)

PDOP - position dilution of precision (00 to 99)
HDOP - horizontal dilution of precision (00 to 99)
VDOP - vertical dilution of precision (00 to 99)
TDOP - time dilution of precision (00 to 99)
firmware version ID

Checksum

Carriage return and Line feed

The LLK (Leica Local Position and GDOP) message provides position in local coordi-
nates in meters and GDOP value. The LLK message is given in the following form:

$GPLLK,hhmmss.ss,ddmmyy,xxxx.xxxx,M,XXXX.XXXX, M,X,X,XX.XX,XXXX.XXXX,M,

*cce<CR><LF>

Definition of LLK message components:

hhmmss.ss
ddmmyy
XXXX.XXXX
M
XXXX.XXXX
M

X

X
XX.XX
XXXX.XXXX

M

*cc
<CR><LF>

UTC time in hours, minutes, seconds of the GPS position
UTC date (day, month, year)

Grid Easting, meters

Meters (fixed text “M™)

Grid Northing, meters

Meters (fixed text “M™)

Quality indicator,

0 = not valid,

1 = GPS Nav Fix (no differentially corrected position),
2 = DGPS Fix (differentially corrected position),

3 = RTK Fix

Number of satellites used in computation,

GDOP

Height, meters

Meters (fixed text “M”)

Checksum

Carriage return and Line feed
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LLQ Data Message

The LLQ (Leica Local Position and Quality) message provides position in local coordi-
nates in meters and position quality in meters. The LLQ message is given in the follow-
ing form:

$GPLLQ,hhmmss.ss,ddmmyy,xxxx.xxxx, M,XXXX.XXXX,M,X,X,XX.XX,XXXX.XXXX,M,
*cc<CR><LF>

Definition of LLK message components:

hhmmss.ss UTC time in hours, minutes, seconds of the GPS position
ddmmyy UTC date (day, month, year)
XXXX.XXXX Grid Easting, meters
M Meters (fixed text “M”)
XXXX.XXXX Grid Northing, meters
M Meters (fixed text “M”)
X Quality indicator,
0 = not valid,

1 = GPS Nav Fix (no differentially corrected position),
2 = DGPS Fix (differentially corrected position),

3 = RTK Fix
X Number of satellites used in computation,
XX.XX Position quality, meters
XXXX.XXXX Height, meters
M Meters (fixed text “M”)
*cc Checksum
<CR><LF> Carriage return and Line feed

GLL Data Message

The GLL message takes the following form:
$GPGLL,ddmm.mmmmm,s,dddmm.mmmmm,s,hhmmss.ss,s*cc<CR><LF>
Definition of GLL message component:

ddmm.mmmmm Latitude in degrees, minutes, and decimal minutes
S s=N or s=S, for North and South latitude
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dddmm.mmmmm
S

hhmmss.ss

S

*ce
<CR><LF>

GGK Data Message

Longitude in degrees, minutes, and decimal minutes
s=E or s=W, for East and West longitude

UTC time in hours, minutes, seconds of the GPS position
Status,

A = valid, V = invalid

Checksum

Carriage return and Line feed

The GGK message contains the GPS position, Time, Date, Position Type, and DOP
information. The GGK is not a standard NMEA data message and it is used in several
Trimble GPS receivers. This message takes the following form:

$PTNL,GGK,hhmmss.ss,ddmmyy,ddmm.mmmmmmmm,s,dddmm.mmmmmmmin,s,
n,qq,p.p,EHT-aa.aaa,M*cc<CR><LF>

Definition of GGK message component:

hhmmss.ss

ddmmyy
ddmm.mmmmmmmim
S
dddmm.mmmmmmm
S

n

qq

p-p
EHT-aa.aaa
M

*cc
<CR><LF>

UTC time in hours, minutes, seconds of the GPS position
Date

Latitude in degrees, minutes, and decimal minutes

s=N or s=S, for North and South latitude

Longitude in degrees, minutes, and decimal minutes

s=E or s=W, for East and West longitude

GPS Quality indicator,

0 = fix not valid or not available,

1 = Autonomous GPS fix, no differentially corrected position,
2 = differential, floating carrier phase integer based solution
(FLOAT),

3 = differential, fixed carrier phase integer-based solution
(FIXED),

4 = differential, code phase only solution (DGPS)

Number of satellites used in fix

DOP of fix

Ellipsoidal height of fix

unit of measure for ellipsoidal height in meters

Checksum

Carriage return and Line feed
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